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Tóm tắt nội dung

Đây là sổ tay hướng dẫn sử dụng LaTeXPiX, một công cụ vẽ hình cho LATEX chạy trên tất cả các hệ
điều hành 32 bit của Microsoftr WindowsTM . Quyển sổ tay nhỏ này sẽ hướng dẫn bạn sử dụng
phần mềm, đồng thời đưa ra một số gợi ý và các thông tin có liên quan. Bạn nên đọc sách hướng
dẫn trước khi làm việc với LaTeXPiX.

Bạn hãy lượng thứ cho chúng tôi về cách viết không chuyên nghiệp khi soạn tài liệu, và đừng ngại
báo cho chúng tôi biết nếu bạn tìm thấy một đoạn văn nào đó không được rõ ràng và dễ hiểu.
Nếu có điều gì thắc mắc, như những hạn chế và lỗi của phần mềm thì xin hãy email cho chúng
tôi. Chúng tôi hy vọng bạn sẽ thích dùng LaTeXPiX và thưởng thức khoảng thời gian nhàn rỗi của
bạn thật thú vị. Để trình bày những thay đổi chính hoặc một vài điểm được thêm vào tài liệu, so
với các phiên bản được biên soạn trước đây, một gạch in đậm có độ dài vừa phải (giống như bên
lề phải của trang này) sẽ được thêm vào. Các liên kết đến các trang web và địa chỉ email sẽ được
chuyển sang màu xanh da trời.

N.J.H.M. van Beurden
beurden@email.com
http://www.beurden.cjb.net

Huỳnh Thị Tuyết Vân
dienbaquanlovenico@yahoo.ca
http://www.hoahocvietnam.com

Quyền lợi của người dùng

LaTeXPiX được phân phối miễn phí. Điều này có nghĩa là:
1. Tất cả bản quyền của LaTeXPiX đều thuộc sở hữu của tác giả, anh N.J.H.M. van Beurden.
2. LaTeXPiX có thể được phân phối miễn phí với một số ngoại lệ dưới đây, cung cấp trọn gói

không được cải biến. Không một cá nhân hay công ty nào được tính phí khi phân phối lại
LaTeXPiX cho người dùng mà không có sự thỏa thuận với tác giả, người giữ bản quyền
phần mềm. Không được đóng gói LaTeXPiX hay phân phối chung với các ứng dụng khác
mà không có sự đồng ý của tác giả.

3. LaTeXPiX ĐƯỢC CUNG CẤP KHÔNG KÈM THEO BẤT CỨ MỘT SỰ ĐẢM BẢO NÀO “BAO
GỒM” CẢ NHỮNG ĐẢM BẢO NGỤ Ý. BẠN SỬ DỤNG VÀ TỰ CHỊU TRÁCH NHIỆM. Anh
N.J.H.M. van Beurden và tôi SẼ KHÔNG CHỊU TRÁCH NHIỆM PHÁP LÝ CHO VIỆC HỎNG
HÓC HAY MẤT DỮ LIỆU HAY BỊ MẤT LỢI NHUẬN KHI BẠN DÙNG PHẦN MỀM NÀY HOẶC
DÙNG NÓ SAI MỤC ĐÍCH.
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ii Tóm tắt nội dung

4. Bạn không được sao chép, đấu giá, nhân bản, cho thuê, bán lại, chỉnh sửa, dịch lại, dịch
ngược mã nguồn, hay chuyển nhượng thành chương trình có license, chuyển thành một
module của các phần mềm có phí khác, ngoại trừ có sự đồng ý của tác giả. Sử dụng phần
mềm trái mục đích cho phép sẽ bị khởi tố trước pháp luật. Tất cả các quyền lợi không được
cho phép đều được phản hồi đến N.J.H.M. van Beurden.

5. Cài đặt và sử dụng LaTeXPiX được chấp nhận theo các điều khoản qui định trong license
này.

6. Nếu bạn không đồng ý với các điều khoản trên thì hãy xóa LaTeXPiX khỏi thiết bị lưu trử và
dừng việc sử dụng phần mềm này.
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Lời nói đầu

Tại sao LaTeXPiX lại xuất hiện?

Ngày nay có nhiều người sử dụng LATEX để soạn thảo tài liệu của họ. Các hình ảnh và môi trường
picture trong LATEX cũng được chèn vào. Môi trường picture đưa ra nhiều hình cơ bản mà
dưới đây chúng được gọi là các “ đối tượng” như là các đường kẻ, vector, elip, đường cong Bezier
. . . Các hình vẽ được tạo ra bằng cách viết các đoạn mã LATEX chứa một cấu dạng nào đó kết hợp
với các đối tượng khác nhau. Tạo các hình vẽ bằng cách viết mã cho LATEX xử lý thì không trực
quan bởi vì bạn chỉ xem được hình vẽ sau khi biên dịch tài liệu bằng LATEX. Và thật khó mà tính
toán hay tưởng tượng ra những hình dáng, kích thước của hình vẽ mà bạn muốn. Do đó có nhiều
ứng dụng đồ họa giúp tạo ra các hình vẽ mà bạn có thể nhìn thấy ngay. Sử dụng giao diện của
các ứng dụng đồ họa này có thể giúp bạn xem được ảnh thật của các hình vẽ bằng mã LATEX. Các
nhân tố của mã hình ảnh trong LATEX được tạo ra theo cấu dạng của đối tượng và sự kết hợp giữa
chúng được sinh ra với giao diện người dùng. Một số giao diện người dùng giúp cho việc tạo ra
các hình vẽ trong LATEX mà chúng tôi biết đó là:

¥ XFig: Một chương trình khá phổ biến làm việc trong hệ UNIX.
¥ JFig: Chạy được trên các hệ điều hành hỗ trợ JAVA. http://tech-www.informatik.uni-

hamburg.de/applets/jfig/
¥ JPicEdt: Một editor rất hoàn chỉnh làm việc trên tất cả các hệ điều hành hỗ trợ JAVA.

http://jpicedt.sourceforge.net/
¥ LaTeXCAD: Chạy trên Windows. Chương trình này cũng khá phổ biến nhưng vẫn còn một số

hạn chế, ví dụ như: không hỗ trợ màu sắc.
¥ TexCad32: Một phiên bản dành cho Windows viết bởi Peter Furlan. Có nhiều hạn chế nhưng

nó đang được hoàn thiện.
¥ QFig: Chạy trên MS-DOS và cũng đã có một phiên bản dành cho Windows nhưng chức

năng rất hạn chế. Và không ai phát triển nó nữa.
¥ WinTpic: Một chương trình được viết bởi Masashi Horii, làm việc rất tốt với các hình vẽ đơn

giản, nó tương đối cũ, phiên bản hiện nay là 3.08 viết cho Windows 95, có một số nút vẫn
để ở tiếng Nhật. m-horii@mbox.kyoto.or.jp

¥ LaTeXDraw: Làm việc trên Unix.
¥ LaTeD: Tiện ích chạy trong MS-DOS. http://www.ctan.org/tex-archive/systems/msdos/lated/

Tất cả các ứng dụng trên đều rất tuyệt, nhưng không có một chương trình nào có những chức
năng mà chúng tôi mong muốn. Một số tính năng mà chúng tôi đã bỏ sót trong nhiều chương trình
đó là:

¥ Hỗ trợ màu trên các đối tượng như hình chữ nhật (hình vuông), elip (hình tròn), đa giác, các
dấu chấm và văn bản.

¥ Hình đổ bóng (sơn màu xám với gradient khác nhau) và tô màu đối tượng.
¥ Chữ in đậm và chữ in nghiêng.
¥ Chèn các hình ảnh như JPEG và PNG.
¥ Mũi tên chỉ mọi hướng với các kiểu đầu mũi tên khác nhau thay vì bị hạn chế bởi lệnh
\vector trong LATEX chuẩn.

¥ Các cung elip thay vì chỉ làm được cung tròn.
¥ Các đường cong Spline.
¥ Hỗ trợ gói PGF.

N.J.H.M. van Beurden and Vietnamese by Thái Phú Khánh Hòa 23 tháng 1 năm 2006

http://tech-www.informatik.uni-hamburg.de/applets/jfig/
http://tech-www.informatik.uni-hamburg.de/applets/jfig/
http://jpicedt.sourceforge.net/
mailto:m-horii@mbox.kyoto.or.jp
http://www.ctan.org/tex-archive/systems/msdos/lated/


iv Lời nói đầu

¥ Và còn rất nhiều tính năng khác . . .
Vì thế tác giả đã bắt tay vào viết LaTeXPiX để tạo ra một ứng dụng thỏa mãn được những đòi hỏi
vừa nêu, nhưng thật không may nó chỉ chạy trên Windows, để có thể có được tất cả các tính năng
của tất cả các ứng dụng đã có, tôi đã kết hợp chúng gói gọn trong một chương trình.

Cảm ơn

Nếu không có sự giúp đỡ của nhiều cá nhân thì, LaTeXPiX đã không hoàn thiện sớm.
¥ Cảm ơn CTAN về các đóng góp và gợi ý.
¥ Ignacio Peñarrocha Alos: Cảm ơn ông về các gợi ý.
¥ Jaime Quintanilla Benavente: Cảm ơn anh đã dịch các thanh công cụ sang tiếng Tây Ban

Nha.
¥ Robert Rutten: Đã cho tác giả gợi ý và giúp phát hiện lỗi cũng như kiểm tra phiên bản beta

này.
¥ Joseph Hilferty: Đã dịch ứng dụng sang tiếng Tây Ban Nha.
¥ Charles B. Cameron: Đã giúp tìm lỗi và cách khắc phục.
¥ Tim Alderson: Nhận xét và giúp tìm nhiều lỗi.
¥ ATK Slawek: Dịch sang tiếng Balan.
¥ Lars Borchert: Hoàn thiện bản dịch tiếng Đức rất chuẩn.

Cuối cùng xin cảm ơn tất cả người dùng LaTeXPiX và những người đã đặt liên kết tới website của
tác giả và đưa LaTeXPiX lên server của họ.
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Chương 1:
Giới thiệu

Chương này sẽ giới thiệu ngắn gọn về LaTeXPiX.

1.1 Các yêu cầu về hệ thống

Để có thể làm việc được với LaTeXPiX bạn cần một hệ thống làm việc với Microsoftr WindowsTM

và trên máy có cài đặt LATEX1. Một phần tử của LATEX được gọi là MikTEX rất phù hợp để dùng
LaTeXPiX. Nó là chương trình được cung cấp miễn phí giống như các sản phẩm TEX khác. Bạn
cũng chẳng cần đến một cái máy tính mới và mạnh để dùng LaTeXPiX mặc dù một máy tính cũ
rích chạy không mấy suôn sẽ cho lắm.

1.2 Giao diện người dùng

Sau khi cài đặt xong, LaTeXPiX sẽ khởi động chương trình một cách tự động. Một cửa sổ hiện lên
và đòi hỏi bạn thiết đặt một số lựa chọn (xem hình 1.1 và 1.2). Giải thích về tất cả các lựa chọn
được nêu trong phần 6.3. Sau này bạn cũng có thể thay đổi các tính năng mặc định rồi chỉ cần
click lên nút OK để chấp nhận thay đổi. Sau khi cửa sổ của các lựa chọn đóng lại lúc này bạn có
thể thấy được giao diện của LaTeXPiX. Bạn có thể nhìn thấy một tấm vải sơn dầu (nền vẽ) mà
bạn có thể vẽ hình ảnh lên, một thanh menu chính nằm phía trên, hai thanh cuộn để cuộn tấm
vải sơn dầu, một thanh công cụ ở phía bên trái và một thanh trạng thái ở phía dưới, ngoài ra còn
có cả thước ngang và thước dọc. Để chuyển đơn vị đo từ cm sang inches (hoặc ngược lại) và để
tăng/giảm kích cỡ của các ô kẻ, bạn có thể dùng các nút “dấu cộng” và “dấu trừ” ở phía trên bên
trái của tấm vải sơn dầu, khu vực mà bạn dùng để vẽ hình, bạn bấm vào mỗi nút để biết chức
năng của chúng. Nhấp lên nút “CM” để chuyển sang chế độ đo bằng “inches” hoặc ngược lại nhấp
nút “IN” để chuyển qua đo bằng centimet.
Xem screenshot của LaTeXPiX ở hình 1.3. Tôi sẽ cập nhật sreenshot của LaTeXPiX mỗi khi có
phiên bản mới.

Hình 1.1: Cửa sổ khởi động của LaTeXPiX

1Trên mỗi phiên bản của LATEX, mà thật ra là LATEX2e
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Hình 1.2: Cửa sổ các lựa chọn trước khi sử dụng LaTeXPiX
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Hình 1.3: Screenshot của LaTeXPiX

1.3 EPIC và EEPIC

Bạn có thể vẽ hình trong LATEX nhưng nhìn chung việc vẽ hình gặp rất nhiều hạn chế. Sunil Podar
ở S.U.N.Y, Stony Brook đã viết ra gói lệnh epic nhằm tăng khả năng đồ họa cho LATEX. Gói này
cung cấp một giao diện đơn giản hơn nhưng mạnh hơn môi trường picture của LATEX chuẩn. Một
số lệnh mới được đưa ra nhằm hỗ trợ việc vẽ các đường liền nét, đường đứt nét, và đường chấm
chấm . . . Tuy nhiên, epic vẫn còn lưu lại những hạn chế của LATEX trong việc vẽ hình ảnh do đó
một số chức năng vẫn còn rất mất thời gian để hoàn thiện và kết quả output thì trông không mấy
đẹp mắt.

tpic là một chương trình xử lý thô dùng với TEX. Nó dùng một tập các special (pdf special và
dvi special là các gói lệnh hỗ trợ tạo ghi chú) lệnh đồ họa (postscript trực tiếp) để vẽ hình. Gói lệnh
eepic là phần mở rộng cho LATEX và EPIC, nhằm giải quyết các hạn chế bằng cách tạo ra các
tpic special. Gói eepic được viết bởi Conrad Kwok. Phần mở rộng được đưa ra bởi gói eepic
là vẽ các đường thẳng ở bất kỳ hướng nào, hình elip đặc2 với bán kính bất kỳ, có nhiều lựa chọn
về độ dày nét vẽ, các cung tròn, spline và hình đa giác. Nhiều người dùng LATEX sử dụng lệnh của
eepic bởi vì chúng dễ dùng và có tính tương thích với hệ điều hành và chương trình duyệt ảnh.

2Hình elip được tô màu kín toàn bộ bề mặt của nó, tiếng Anh họ dùng thuật ngữ “filled ellipse” rất gọn còn trong Tiếng Việt
thật khó mà giải thích, có bạn có từ nào phù hợp hơn xin hãy cho người dịch biết.
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1.4 DVIPDFM

Gói dvipdfm là một tiện ích chuyển đổi file DVI sang PDF, kí tự cuối cùng, M là chữ cái đầu tiên
trong tên người tạo ra gói lệnh này, Marc Wicks. Nó có một số tính năng sau:

¥ Hỗ trợ tạo danh mục tóm tắt trong PDF được gọi là bookmarks và lời chú giải (bao gồm cả
hyperlink (siêu liên kết)) gần như hỗ trợ tốt đối với các Acrobat Distiller pdfmark.

¥ Hỗ trợ các DVI special như là HyperTeX (HTML), TPIC, các special màu, PSfile và các
PostScript special khác.

¥ Không hỗ trợ cho việc đính kèm file MetaPost output và đính kèm các file PostScript bất kỳ,
nên cần sự trợ giúp của một chương trình bên ngoài.

¥ Hỗ trợ các PDF thumbnail với sự tham gia của GhostScript để tạo ra các thumbnail (ảnh thu
nhỏ).

¥ Có khả năng chèn các hình ảnh ở dạng bitmap JPEG và PNG như là các đối tượng được gói
gọn.

¥ Hỗ trơ các font cục bộ và nén để giảm dung lượng file.
¥ Hỗ trợ các font tái mã hóa để nhận được các bảng mã không được hỗ trợ đầy đủ trong bộ

sản phẩm trọn gói Acrobat.
¥ Và còn nhiều hơn thế nữa.

Để dùng dvipdfm làm công cụ chuyển đổi DVI sang PDF, cho phép đính kèm các hình ảnh JPEG
và PNG, thì bạn phải chèn lựa chọn \documentclass[...dvipdfm...]{...} vào tài liệu
nguồn của bạn. Xem sách hướng dẫn sử dụng dvipdfm [2] để biết thêm chi tiết.

1.5 PGF

PGF3 là một gói lệnh vẽ hình được tạo bởi Till Tantau. PGF viết tắt của ba từ Portable Graphics
Format (Định dạng đồ họa khả chuyển). Nó là một gói lệnh TEXmacro package cho phép tạo tạo
ra các dạng đồ họa dùng môi trường pgfpicture và các macro để vẽ các đường thẳng, đường cong,
hình chữ nhật, và nhiều đối tượng đồ họa khác. Ứng dụng của nó tương tự gói lệnh pstricks hoặc
môi trường picture thông thường của LATEX.
Việc hỗ trợ cho PGF trong LaTeXPiX đã bắt đầu từ lâu và trong tương lai nó sẽ được quan tâm
nhiều. Bạn có thể xem và cảm nhận các tùy chọn của PGF được nêu ra trong tài liệu này. Ý tưởng
cho tương lai là tất cả các đối tượng sẵn có trong EEPIC cũng có thể chuyển thành PGF.

1.6 Chú ý quan trọng cho người dùng Windows 95/98/ME

Nếu bạn không có hệ điều hành WinNT thì một số chức năng đồ họa không thể dùng được trong
LaTeXPiX. Khi chạy chương trình lần đầu tiên thì một cửa sổ xuất hiện cảnh báo về việc này.
Những người dùng Microsoft Windows 95/98 và WinMe không thể nhìn được dấu chấm/dấu gạch
ngang, nằm tách riêng biệt nhau trong LaTeXPiX. Tuy nhiên, sự chuyển đổi thích hợp sẽ được
thực hiện.

1.7 Mục tiêu

Mục đích chính của LaTeXPiX là tạo ra các hình vẽ cho LATEX với sự hỗ trợ của giao diện người
dùng rất dễ sử dụng. Các hình vẽ vẽ có thể chuyển qua mã của LATEX, mà chúng là những lệnh

3Xem [3] sách hướng dẫn sử dụng PGF.

23 tháng 1 năm 2006 N.J.H.M. van Beurden and Vietnamese by Thái Phú Khánh Hòa



1. Giới thiệu 7

của eepic. Đối với mục đích này, LaTeXPiX dùng một file script4 (với phần ,ở rộng là .lpx) để
mô tả cho các đối tượng đã được vẽ. Mã chuyển đổi có thể được ghi vào một file (với phần mở
rộng là .eepic hoặc là .pgf) và có thể được chèn vào trong file LATEX nguồn. bạn cũng có thể
copy trực tiếp các lệnh chuyển đổi vào trong file LATEX nguồn.

Khi tài liệu LATEX được biên dịch bạn sẽ nhận được một file gọi là "device independent" (file “.dvi”).
File DVI này có thể chuyển thành nhiều định dạng khác như postscript hoặc PDF (Portable
Document Format của Adober), xem [1]. Với chương trình dvipdfm [2] bạn có thể chuyển file
DVI sang dạng PDF và có thể xem nó với Adober AcrobatTM Reader, tài liệu dạng pdf có tính khả
chuyển cao vì nó vẫn giữ nguyên định dạng ban đầu khi bạn mở trên các hệ điều hành khác nhau.

Do đó mục đích chủ yếu của LaTeXPiX là chuyển các hình vẽ được tạo trên một user interface
(giao diện người dùng) dựa vào một tập các lệnh của gói eepic vậy nên những hình được định
dạng bằng LATEX cũng có thể chuyển được qua dạng PDF. Lợi điểm chính của các hình ảnh được
tạo bằng LATEX thay vì dùng những chương trìng phụ trợ khác hoặc postscript là toàn bộ tài liệu
LATEX có thể dùng cùng loại font chữ, tạo ra các hình ảnh LATEX thì tương đối đơn giản, ít tốn kém
và tốn ít dung lượng trên đĩa cứng hơn . . .

Bởi vì gói lệnh eepic dùng các tpic special, nhưng nó không thể dùng kết hợp với gói PDFLATEX.
Khi đó bạn nên dùng PGFLATEX để biên dịch các hình vẽ.

1.8 Các file phong cách (style files)

Bạn sẽ cần đính kèm một vài style file (.sty) vào cấu hình của tài liệu LATEX nếu như bạn muốn
hiển thị các hình ảnh dưới dạng mã lệnh của LATEX. LaTeXPiX sẽ đòi hỏi một số style file còn các
gói lệnh khác thì phụ thuộc vào đối tượng mà bạn sử dụng trong hình vẽ. Việc yêu cầu các style
file sẽ được xác định cho mỗi loại đối tượng.

Một vài style file được liệt kê trong phần này đã sẵn có trong các phiên bản phân phối của LATEX.
Tuy nhiên một số style file cần một phiên bản xác định nào đó, để có thể kích hoạt được các chức
năng của chúng nhằm hoạt động tốt với LaTeXPiX. Các thử nghiệm đã cho thấy rằng kết quả được
đưa ra bởi LATEX khác nhau khi sử dụng không đúng phiên bản của các gói lệnh thậm chí không
thể xử lý hình ảnh được trong quá trình biên dịch tài liệu. Do vậy bạn nên xem kĩ mỗi style file.
Tất cả các style file được yêu cầu bạn có thể cài đặt chúng qua bộ hỗ trợ cài đặt được
gọi là menu "Style File Installer" trong LaTeXPiX. Để mở menu này bạn mở theo thứ tự sau
Settings→Install LaTeX Files. Hình 1.4 sẽ cho thấy giao diện của menu cài đặt "Style
File Installer". Hầu hết các style file mới nhất sẽ được hiện lên ở đây. Nếu bạn không thấy chúng
thì xin hãy liên hệ với tác giả để cập nhật các phiên bản mới hơn. Chọn các gói cập nhật cần thiết
và lưu trữ chúng trong folder cất trữ style file. Xem LATEX manual để biết nơi mà các file này được
cài đặt hoặc đơn giản là ghi đè lên các phiên bản cũ.

4Hệ thống chữ viết.
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Hình 1.4: Menu hỗ trợ cài đặt các style file “Style File Installer”

Các style file được yêu cầu đó là:
¥ epic.sty: Style file cho môi trường picture mở rộng. Chú ý rằng gói này có nhiều phiên bản.

Nếu bạn muốn chắc chắn 100% để có được một phiên bản thích hợp để dùng với LaTeXPiX
thì bạn nên cài đặt style file này qua bộ hỗ trợ cài đặt "Style File Installer".

¥ eepic.sty: Style file cho môi trường picture mở rộng. Gói lệnh này cũng có nhiều phiên bản
khác nhau, tôi khuyên bạn nên cài đặt gói thích hợp thông qua "Style File Installer".

Các style file phụ thuộc đó là:
¥ bez123.sty và multiply.sty hoặc ebezier.sty và calc.sty: Các style file cho đường cong

Bezier. Bạn chỉ cần đính kèm một trong những cặp style file nếu bạn dùng bất kỳ đường
cong Bezier nào trong hình vẽ của bạn. Cả hai gói lệnh ebezier và bez123 sẽ được kích
hoạt và hoạt động tốt mà bạn có thể dùng một trong số chúng và vẫn giữ nguyên được các
lợi điểm.

¥ curves.sty: Style file dùng để vẽ các đường cong, ở đây nó được dùng để vẽ các cung
tròn. Bạn phải đính kèm gói này khi bạn vẽ các cung tròn hay cung elip. Nhớ rằng gói lệnh
eepic.sty rất thích hợp cho việc tạo ra các cung tròn khi chuyển DVI sang PDF với công
cụ dvipdfm tuy nhiên quá trình chuyển đổi thỉnh thoảng vẫn không thực hiện được. Do vậy
gói curves.sty đã được chọn để dùng cho các cung tròn và các cung elip.
Chú ý rằng bạn phải dùng phiên bản đã được chỉnh sửa của gói lệnh này (để có thể cài đặt
được từ "Style File Installer" của LaTeXPiX), mà không phải là gói nguyên bản được phân
phối cùng với môi trường LATEX của bạn đâu nhé.
Lệnh \arc được định nghĩa trong cả hai eepic.sty và gói chưa được chỉnh sửa
curves.sty. Điều này sẽ gây nên một lỗi khi bạn compile5 (biên dịch) tài liệu bằng LATEX
khi dùng lệnh \arc đã được định nghĩa lại. Để loại bỏ vướng mắc này, lệnh \arc trong file
curves.sty nên được chỉnh lại thành \Arc để ngăn không cho phát sinh lỗi trong suốt quá
trình biên dịch với LATEX.

¥ rotating.sty: Style file giành cho việc quay hướng của văn bản. Khi bạn dùng frambox có
một góc quay khác 0 thì bắt buộc bạn phải đính kèm gói lệnh này.

Các style file tùy chọn:

5bạn dùng LATEX thì một điều chắc chắn bạn phải biết “compile” là gì nếu không, khi nói ra thì có nhiều người sẽ cười bạn
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¥ latexpix.sty: Trong style file tùy chọn này có lệnh biểu thị cho việc chèn các hình ảnh của
LaTeXPiX vào trong tài liệu LATEX.

Lệnh được yêu cầu để input các hình vẽ LaTeXPiX vào trong tài liệu của bạn cũng có thể được
copy vào clipboard và paste vào bất cứ chỗ nào trước dòng đặt lệnh này. Thực hiện điều này sẽ
làm cho file latexpix.sty bị quá hạn. Việc paste bằng tay cũng có thể được thực hiện bằng việc
nhấn nút "Copy LaTeX Command To Clipboard", xuất hiện trong menu "Style File Installer" (xem
Hình 1.4) và sau đó paste lệnh này ở một vị trí thích hợp bằng cách nhấn CTRL+V trong editor yêu
thích của bạn như WinEdt, Winshell . . .

1.9 Các lệnh cần thiết

Khi bạn chuyển một file được tạo trong LaTeXPiX sang một file để chèn vào LATEX thì bạn sẽ thu
được một file với tên mở rộng là .eepic hoặc .pgf. Để chèn file đã được chuyển đổi vào tài liệu,
bạn cần tạo một lệnh mới trong LATEX. Bạn cũng có thể dùng file latexpix.sty đã được cung
cấp để làm điều này (xem phần 1.8) hay bạn có thể định nghĩa lại lệnh theo cách thủ công. Lệnh
cơ bản để chèn hình LaTeXPiX là:
\newcommand{\LaTeXPiX}[3]{

\begin{figure}[ht]
\begin{center}

\input{#1}
\caption{#2}
#3

\end{center}
\end{figure}

}

Lệnh \vspace có thể kéo dãn khoảng cách chiều dọc lên biên trên và biên dưới của hình. Giả sử
rằng bạn đặt tên output file latexpix.eepic bạn có thể chèn file này vào LATEX bằng các dòng
sau:
\LaTeXPiX{latexpix.eepic}

{Đây là một hình được tạo bởi LaTeXPiX}
{\label{fig:LaTeXPiX-vidu}}

1.10 Các menu và các phím nóng

Các lệnh được sử dụng chủ yếu trong LaTeXPiX đều có thể dùng các phím nóng để hiển thị chúng.
Một danh sách liệt kê các tổ hợp phím nóng có thể tìm thấy ở phần phụ lục A. Nhưng bạn cũng có
thể dùng menu chính để duyệt qua các lệnh đã được tạo sẵn.

1.11 Gỡ bỏ LaTeXPiX

Cách tốt nhất để gỡ bỏ toàn bộ phần mềm LaTeXPiX (ngoại trừ shortcut đã được tạo trên destop)
thông qua bộ công cụ cài đặt chuẩn trong Windows. Trước khi gỡ bỏ thì bạn nên tắt LaTeXPiX.
Chú ý rằng các thiết lập của LaTeXPiX cũng như mã đăng ký (mã đăng ký sẽ được cung cấp khi
bạn liên hệ với tác giả) sẽ không được gỡ bỏ.
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Chương 2:
Các đối tượng sẵn có

Chương này sẽ đề cập đến tất cả các hình dạng có thể có của các đối tượng trong
LaTeXPiX. Ví dụ như các hình vẽ sẽ định hình cho các đối tượng.

2.1 Các đường kẻ

Các đường kẻ có thể được vẽ trong mọi hướng với nhiều màu sắc, độ rộng và lựa chọn về kiểu
dáng (liền nét, chấm chấm, và đứt nét). Bạn sẽ được yêu cầu để xác định hai điểm đầu cuối của
đường vẽ.
Hình 2.1 cho thấy các đường vẽ có thể thực hiện được trong LaTeXPiX:

Hình 2.1: Các đường vẽ thử nghiệm với LaTeXPiX

2.2 Các vector

Các vector không thể có hướng bất kỳ giống như các đường kẻ có. Hình 2.2 sẽ cho thấy các
hướng có thể có của một vector khi nó được bao quanh bởi một hình chữ nhật. LaTeXPiX sẽ tự
động xác định một vector có thể vẽ được hay không, do đó bạn nên gắn vector với bộ định vị. Các
vector cũng có thể được vẽ bằng đường nét liền. Bạn cũng có thể dùng các mũi tên thay cho các
vector nên bạn có thể vẽ chúng ở bất kỳ độ nghiêng nào với các mũi tên có kiểu dáng khác nhau.

6

¾
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y

Y

I

}

Hình 2.2: Hình vẽ thử nghiệm các vector trong LaTeXPiX

2.3 Mũi tên

Các mũi tên thì có thể có hướng bất kỳ (các vector thì không có độ nghiêng bất kỳ được) do
đó chúng có nhiều lợi điểm hơn vector. Việc vẽ mũi tên được tác giả tạo ra theo cách truyền thống
và phương pháp này không phải là các lệnh vẽ hình chuẩn trong LATEX. Đầu mũi tên được vẽ ra
bằng cách đặt một hình đa giác với hình dáng là một mũi tên ở cuối đường kẻ. Các mũi tên có thể
là đường liền nét, chấm chấm hay đứt nét, nhưng các đầu mũi tên luôn là những hình được bao
quanh bởi các đường liền nét. Hình 2.3 sẽ cho thấy các khả năng có thể là đối tượng mũi tên.
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Hình 2.3: Hình vẽ thử nghiệm mũi tên trong LaTeXPiX

2.4 Đường cong Bezier

Các đường cong Bezier mà bạn có thể vẽ sẽ có một điểm đầu và điểm cuối với hai điểm điều
khiển. Hình 2.4 cho thấy các ví dụ về đường cong Bezier:

Hình 2.4: Ví dụ về đường cong Bezier trong LaTeXPiX

Số điểm được dùng để vẽ đường cong Bezier có thể được định rõ và chỉnh sửa cho mỗi đối
tượng Bezier riêng biệt. Bạn cũng có thể vẽ được đường Bezier liền nét và đứt nét. Tuy nhiên có
thể thu được đường cong Bezier chấm chấm mờ, bằng việc xác lập một số lượng tương đối thấp
mật độ các dấu chấm. Chú ý rằng khoảng cách cục bộ của các dấu chấm là không cố định đối với
các đường cong Bezier khi bạn muốn vẽ các đường cong mờ (không rõ ràng). Hình 2.5 cho thấy
các dạng tùy chọn của đường cong Bezier ("Bezier Options"):

Hình 2.5: Các dạng tùy chọn Bezier

2.5 Các cung tròn và cung elip

Hỗ trợ vẽ cung elip có lẽ là một trong những tính năng mạnh của LaTeXPiX mà chúng không có
mặt trong gói lệnh eepic.sty. Trong gói lệnh eepic.sty chỉ có cung tròn được đưa ra nhưng
chúng được dùng trong tài liệu hướng dẫn của eepic vì lý do bất cập của nó. Do đó đối với cả hai
cung tròn và cung elip thì gói lệnh curves.sty là bắt buộc phải dùng.

Bạn phải chèn file curves.sty file, gói này được phân phối chung với LaTeXPiX (được cài đặt
thông qua "Style File Installer") khi bạn muốn chuyển đổi các cung elip một cách hợp thức.
Việc chỉnh sửa file nguồn đã được thực hiện để mọi thứ làm việc một cách trôi chảy. Nên các cung
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tròn chỉ có thể chuyển được qua LATEX khi phiên bản đã chỉnh sửa được dùng, không nên dùng
style file được phân phối cùng với LATEX đôi khi nó kị với các style file khác! Hình 2.6 cho thấy một
số ví dụ về các cung.

.................................................................................................................................................................................................................................................................................... .......... .......... ............ ............. ...................... ........................ ......................... ......................... ......................... ......................... ........................ ......................

Hình 2.6: Ví dụ về các cung trong LaTeXPiX

2.6 Hình chữ nhật

Các hình chữ nhật có thể được vẽ ra theo nhiều kiểu khác nhau giống như trong hình 2.7.
Khi bạn vẽ một hình chữ nhật được tô màu thì bạn sẽ không nhìn thấy đường viền bao xung quanh
nó. Còn khi bạn vẽ một hình chữ nhật bình thường hay đổ bóng thì bạn nhìn thấy được border1

của nó. Các hình vuông cũng có thể được vẽ ra theo kiểu của hình chữ nhật và hãy nhớ rằng bạn
sẽ không tạo được bóng đổ hay tô màu hình chữ nhật khi border của nó là đường đứt nét hay
đường chấm chấm.

Hình 2.7: Các kiểu hình chữ nhật trong LaTeXPiX

2.7 Hình vuông

Có chung các qui tắc như đối với hình chữ nhật được áp dụng ở đây. Nhưng các hình
vuông thì chiều dài và chiều rộng bằng nhau. Hình 2.8 sẽ cho thấy một số hình vuông có thể vẽ
được.

Hình 2.8: Hình vuông trong LaTeXPiX

1đường viền
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2.8 Đa giác

Một hình đa giác là một tập hợp các đường thẳng nối với nhau mà có thể tô được bất cứ
màu nào khi hình vẽ được khép kín. Hình 2.9 cho thấy một số đa giác có thể vẽ được nhưng số
đường kẻ của đa giác thì giới hạn, khi số đường kẻ nhiều đạt đến số giới hạn thì LaTeXPiX sẽ tự
động khép kín hình đa giác và tạo ra đối tượng vẽ. Khi bạn muốn khép kín hình đa giác bạn có thể
làm việc này bằng cách:

1. Đánh giấu điểm cuối lên vị trí chính xác của điểm ban đầu.
2. Nhấn phím BackSpace thì LaTeXPiX sẽ tự động khép hình cho bạn.

Để giữ cho hình đa giác vẫn mở thì nhấn CTRL+BackSpace sau khi bạn tìm được vị trí của điểm
cuối.

Hình 2.9: Hình đa giác trong LaTeXPiX

2.9 Các đường spline

Một spline2 là một đường cong đi qua một số điểm xác định và chúng có thể được tô các
màu bất kỳ khi hình vẽ khép kín. Hình 2.10 cho thấy một số đường spline có thể vẽ được. Số điểm
trong một đường spline là giới hạn, khi số điểm trong hình đạt đến giới hạn thì LaTeXPiX tự động
đóng kín hình để tạo ra đối tượng. Khi muốn đóng một đường spline thì có thể làm như sau:

1. Đánh dấu điểm cuối ở một vị trí chính xác với điểm bắt đầu của hình vẽ.
2. Nhấn phím BackSpace. LaTeXPiX sẽ tự động đóng đối tượng lại cho bạn.

Để giữ cho đường cong spline vẫn ở trạng thái mở thì nhấn tổ hợp phím CTRL+BackSpace trong
khi bạn đang định vị điểm cuối của nó.

2Trong đồ họa máy tính, một đường cong trơn đi qua 2 hay nhiều điểm. Các đường spline thường được tạo ra bằng các công
thức toán học. Hai loại spline phổ biến nhất là đường cong Bezier và đường cong B-spline.
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Hình 2.10: Các hình spline trong LaTeXPiX

2.10 Hình elip

Các hình elip có thể được vẽ theo nhiều kiểu khác nhau giống như trong hình 2.11. Khi
bạn vẽ một elip phủ màu bạn sẽ không nhìn thấy đường viền xung quanh. Các hình tròn cũng có
thể vẽ theo kiểu elip. Nhưng hãy nhớ rằng các hình elip phủ màu và đổ bóng sẽ không vẽ được
khi bạn chọn đường viền là đường đứt nét hay chấm chấm.

Hình 2.11: Hình elip vẽ được trong LaTeXPiX

2.11 Hình tròn

Qui tắc áp dụng cho hình tròn cũng được áp dụng tương tự như trên hình elip. Nhưng
các hình tròn có cùng đường kính về chiều ngang và chiều dọc. Hình 2.12 cho thấy một số hình
tròn có thể vẽ được trong LaTeXPiX.

Hình 2.12: Hình tròn trong LaTeXPiX
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2.12 Hình oval

Các hình oval là những hộp chữ nhật mà các góc của chúng bị gọt tròn. Qui tắc áp dụng cũng
giống như của hình elip nhưng có thêm một giới hạn. Hình 2.13 cho thấy một số hình oval vẽ được
trong LaTeXPiX. Hình oval chỉ có thể để trống không tô màu hoặc làm đổ bóng được và mức độ
uốn cong của các góc có thể hiệu chỉnh được.

Hình 2.13: Hình oval trong LaTeXPiX

Tất cả các lựa chọn của hình oval có thể thiết lập và thay đổi được nhờ thẻ "Oval Options" ,
xem hình 2.14:

Hình 2.14: Thẻ lựa chọn của hình oval

2.13 Điểm chấm

Hình 2.15 cho thấy các điểm chấm được vẽ bằng LaTeXPiX. Một dấu chấm có một đường
kính chuẩn là 4 và có thể đổi thành các màu sẵn có trong LaTeXPiX. Các qui định cho hình tròn
cũng được áp dụng lên điểm chấm.

Hình 2.15: Điểm chấm được vẽ trong LaTeXPiX

2.14 Văn bản thông thường

Để thêm văn bản hoặc các công thức vào hình vẽ của bạn, có hai phương án khả thi. Trước
hết, bạn có thể thêm văn bản vào bằng cách xác định tọa độ để bắt đầu nhập văn bản. Đây gọi
là ’Text’. Bạn cũng có thể xác định một box trong đó bạn có thể nhập văn bản vào với một số tính
năng đặc biệt như các vị trí ngang/dọc hoặc văn bản có thể quay theo các góc khác nhau. Những
định dạng này gọi là ’Framebox Text’. Chú ý rằng tất cả văn bản hiển thị trên màn hình đều được
mặc định với cỡ chữ 10, 11, 12 phụ thuộc vào những thiết lập trong preferences menu. Cỡ chữ
trên màn hình tương đương với các cỡ chữ mặc định ở 10, 11, 12pt trong LATEX. Do đó bạn có thể
kết hợp cỡ chữ mặc định trong LATEX theo mặc định trong LaTeXPiX (nhưng không thể làm ngược
lại). Đối với văn bản thông thường, hình 2.16 có nêu ra một vài ví dụ về các kiểu chữ khác nhau
sẵn có. Màu chữ có thể thay đổi mặc cho không thể quay chiều của văn bản hay canh lề, do vậy
bạn cần framebox.
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Normal Text

Bold Text

Italic Text

Bold Italic Text
Hình 2.16: Kiểu chữ trong LaTeXPiX

2.15 Văn bản trong FrameBox

Một framebox là một hình chữ nhật với văn bản được đặt bên trong nó và cho phép căn lề theo
nhiều cách và bạn có thể quay hướng của văn bản. Bạn có thể dùng đối tượng này ví dụ như: khi
vẽ một sơ đồ có chứa các hình chữ nhật trống3 cần căn giữa văn bản bên trong nó. Bằng việc
thêm một framebox có cùng kích cỡ giống như các hình chữ nhật mà bạn cần thì bạn có thể căn
giữa văn bản bên trong các hình chữ nhật này. Màu chữ có thể thay đổi được và sự quay chiều
văn bản cũng có thể thực hiện được dễ dàng.
Để có thể quay được chiều của văn bản, bạn phải đính kèm file rotate.sty vào danh sách các
gói lệnh LATEX của bạn. Điều này chỉ cần thiết khi bạn quay chiều của văn bản một góc khác zero.
Nhớ rằng bạn phải lấy style file từ LaTeXPiX để có thể quay framebox của bạn với một góc 180 ◦.
Style file chuẩn có chứa một lỗi do vậy khi bạn compile với dvipdfm sẽ tạo ra lỗi. File được cung
cấp theo LaTeXPiX không chứa lỗi này.
Chú ý thêm rằng hướng của văn bản sẽ không quay khi xem với Yap. Nhưng khi chuyển qua PDF
thì chiều quay thực của văn bản sẽ hiển thị. Hình 2.17 có nêu ra một vài ví dụ về framebox:

LT CT RT

LC CC RC

LB CB RB

LT C
T

RT

LC C
C

R
C

LB C
B

R
B

LT CT RT

LC CC RC

LB CB RB

LT C
T

R
T

LC

C
C

R
C

LB

C
B

R
B

CC CC CC

CC CC C
C

C
C

C
C

C
C

C
C CC CC

CC CC CC

CC CC CC

CC CC CC
CC CC CC

C
C

C
C

C
C

C
C C
C CC

CC CC CC

CC CC CC

Hình 2.17: Văn bản trong framebox của LaTeXPiX

Đối với các đối tượng framebox và văn bản thông thường, một định dạng sẵn có, trong đó các đối
tượng có thể được hiệu chỉnh. Định dạng "Text Editor" được miêu tả trong hình 2.18:

3không phủ màu mà chỉ có đường viền xung quanh nó
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Hình 2.18: Mẫu định dạng văn bản ”Text editor”

Bạn có thể thêm nhiều dòng văn bản mà chúng sẽ được tách biệt với lệnh \shortstack khi
chuyển sang LATEX code(mã). Chú ý rằng cho dù nhiều hàng được hiển thị trong LaTeXPiX như
một hàng đơn và việc kết thúc một hàng được xác định bằng kí tự "1". Một tính năng hữu dụng
khác là văn bản của một framebox đã có sẵn có thể thay đổi bằng cách nhấp kép trong khu vực
của framebox, và text editor sẽ được tự động mở ra.

2.16 Hình ảnh

JPEG và một số dạng của dạng ảnh PNG để làm đẹp những hình ảnh mà bạn muốn minh họa.
Trước hết, bạn được yêu cầu để xác định góc trên bên trái nơi mà hình ảnh được chèn vào. Kế
đến chọn file của ảnh thật để đính kèm.

Nhớ rằng filename(tên file) của file hình ảnh dùng để chèn vào phải được viết dưới dạng chữ in
thường.

Do vậy một file được đặt tên ví dụ như: Image.JPG sẽ không được chấp nhận và nếu file này
được đổi thành image.jpg sẽ thỏa mãn điều kiện trên. Chú ý rằng các dạng ảnh JPEG và PNG
cần có một khung bao xung quanh khi chèn vào trong LATEX. Khung này có thể được tạo bằng
một freeware gọi là ebb.exe, chương trình này được phân phối với gói dvipdfm hoặc có thể
được LaTeXPiX tự động tạo ra. Để bật tính năng tự động tạo khung bao quanh đối tượng trong
LaTeXPiX, chọn "Autocreate Image .bb File" trong preferences menu (xem phần 6.3). Hình ảnh
mà bạn chèn vào trong hình vẽ của bạn phải được đặt trong cùng thư mục với file output của
LaTeXPiX (với tên mở rộng là .eepic hoặc .pgf). Hình 2.19 đưa ra một ví dụ về việc chèn các
hình ảnh vào trong các hình vẽ LATEX.
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Ảnh PNG Ảnh JPG

Hình 2.19: Chèn hình trong LaTeXPiX

Chú ý rằng các hình ảnh JPEG và PNG chỉ có thể được chèn vào khi dùng dvipdfm để chuyển
file DVI sang PDF. Xem phần 1.4 để biết thêm chi tiết. Không phải tất cả các loại ảnh PNG và
JPEG đều chèn được vào LaTeXPiX đâu các bạn nhé!
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Chương 3:
Các khả năng vẽ hình

Chương này sẽ cho bạn thấy những gì mà bạn có thể thực hiện được với việc vẽ các đối tượng.

3.1 Tọa độ

Để thay đổi các điểm tọa độ của một đối tượng đơn nào đó, thì bạn chọn đối tượng và nhấn
CTRL+F1. Thẻ dùng để thay đổi tọa độ sẽ xuất hiện giống như trong hình 3.1:

Hình 3.1: Thẻ dùng để thay đổi tọa độ của đối tượng

Trong hộp thoại đổ xuống cho phép lấy một điểm nằm trên đối tượng đang được chọn để có thể
chỉnh sửa. Nhớ rằng sau khi mỗi điểm riêng biệt được chỉnh sửa bạn nhấp nút apply để sự thay
đổi có hiệu lực. Và nhấn nút close để tắt thể lệnh.

3.2 Màu sắc

Để đặt màu cho toàn bộ đối tượng nhấn F2, để thay đổi màu của đối tượng đã chọn bạn phải
nhấn CTRL+F2 sau khi chọn. Trong cả hai trường hợp hộp chọn màu sẽ xuất hiện giống như trong
hình 3.2:

Hình 3.2: Hộp chọn màu
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Hình 3.3 cho thấy các màu có sẵn trong LaTeXPiX mặc dù tất cả các màu RGB có thể sử dụng
được trên hình vẽ của bạn.

Hình 3.3: Màu có sẵn trong LaTeXPiX

3.3 Đổ bóng

Khi một đối tượng được làm đổ bóng nó có thể được phủ màu xám với tỉ lệ từ 0 đến 100%, với
một bước nhảy 5%. Điều này có thể thực hiện thông qua thẻ "Select Grayscale" được minh họa
trong hình 3.4:

Hình 3.4: Thẻ điều chỉnh mức độ đổ bóng

Để đặt chế độ bóng đổ đều cho toàn bộ hình nhấn F3. Để thay đổi cường độ của bóng, nhấn
CTRL+F3 sau khi đã chọn đối tượng. Hình 3.5 minh họa các mức độ đổ bóng có thể chọn trong
LaTeXPiX.

Hình 3.5: Minh họa thử nghiệm đổ bóng trong LaTeXPiX

3.4 Đầu mũi tên

Đầu mũi tên có thể được thay đổi nhờ thẻ "Select Arrowhead" được minh họa trong hình 3.6.
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Hình 3.6: Thẻ tùy chọn cho các kiểu đầu mũi tên

Tất cả các kiểu đầu mũi tên có thể vẽ trong LaTeXPiX được minh họa trong hình 3.7 là một ví dụ.
Để đặt toàn bộ mũi tên có kiểu giống nhau nhấn F4. Để thay đổi kiểu đầu mũi tên của đối tượng
được chọn nhấn CTRL+F4.

Hình 3.7: Các kiểu đầu mũi tên vẽ được trong LaTeXPiX

3.5 Tùy chọn của nét vẽ

Tùy chọn nét vẽ của hầu hết các đối tượng có thể được thiết đặt thông qua thẻ "Line Options"
được minh họa trong hình 3.8. Các kiểu nét vẽ có thể là đường liền nét, đường đứt nét và đường
chấm chấm. Đối với trường hợp khi đường đứt nét hoặc chấm chấm được chọn, thì kiểu dấu
chấm/đứt nét có thể được thiết đặt riêng biệt. Độ dày của các đường vẽ có thể được thiết lập thông
qua biểu thức trong unitlengths. Để mặc định kiểu nét vẽ cho toàn bộ các đường vẽ nhấn F5. Để
thay đổi kiểu nét vẽ của một đối tượng được chọn nhấn CTRL+F5.

Hình 3.8: Thẻ tùy chọn nét vẽ
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Chương 4:
Quản lý file

Lời giải thích được đưa ra dựa trên cách làm việc với các file trong LaTeXPiX.

4.1 Tên mở rộng của các file

Để lưu các đối tượng hình vẽ, LaTeXPiX dùng một ngôn ngữ script đặc biệt. Bạn có thể lưu trữ
hình vẽ bằng cách lưu các lệnh script vào file. Một file với tên mở rộng .lpx sẽ được lưu. Khi bạn
muốn chèn hình vẽ vào LATEX thì bạn phải chuyển lệnh LaTeXPiX script sang LATEX code. Và kết
quả là lệnh LATEX có thể lưu vào một file với tên mở rộng là .eepic hoặc .pgf.

4.2 Giải pháp khuyến cáo

Để giữ cho LATEX setup của bạn gọn gàng, sau đây là lời khuyên dành cho các thư mục và các
file setup được mô tả trong phần này. Trong mọi trường hợp bạn muốn tách riêng các file văn bản
LATEX khỏi các file đính kèm như là các hình vẽ từ LaTeXPiX, các hình ảnh JPEG/PNG hoặc các
file không phải là file nguồn LATEX. Xuất phát từ quan điểm cá nhân, tôi khuyên bạn nên tạo ra các
thư mục con (subdirectory) bên trong thư mục nơi mà bạn lưu file .tex:

¥ files: Đây là tất cả các file nguồn từ LaTeXPiX sẽ được lưu trữ trong file (với tên mở rộng
là .lpx).

¥ pic: Là các file đã được chuyển qua LATEX code và sẽ được lưu trong file (với tên mở rộng là
.eepic hoặc .pgf).

Các thư mục con vừa nêu trên: files và pic chỉ là các ví dụ, thực tế bạn có thể đặt tên cho thư
mục tùy thích. Bằng cách dùng cấu trúc thư mục như thế này, các file nguồn LATEX được tách riêng
biệt từ các file phụ trợ bên ngoài mà chúng được tham chiếu bởi source code của LATEX file. Một
cấu trúc thư mục điển hình mà bạn có thể xem qua như dưới đây:

files/
hinhve1.lpx
hinhve2.lpx

pic/
hinhve1.eepic
hinhve2.pgf

chuong1.tex
chuong2.tex
phuluc1.tex
tailieuchem.tex

Trong ví dụ trên, hinhve1.eepic có thể được dùng trong chuong1.tex và được tham chiếu
bằng (xem chương 1.9): \LaTeXPiX{pic/hinhve1.eepic}. File LaTeXPiX script được đặt
trong file files/hinhve1.lpx.

Các chú ý quan trọng cho người dùng WinEdt: Từ WinEdt bạn có thể xóa các file mà bạn đang
làm việc với chúng. Môi trường đang làm việc sẽ tương đương với thư mục nơi mà các file nguồn
LATEX (với tên mở rộng là .tex) được lưu trữ. Theo mặc định, LATEX cũng tạo các file với tên mở
rộng là .eepic hoặc .pgf, được dùng để tạo bảng mục lục. Nếu bạn đặt các file của LaTeXPiX
đã được chuyển đổi vào trong môi trường mà bạn đang làm việc thì những file này có thể bị xóa
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bởi WinEdt khi bạn làm công việc dọn dẹp thông qua một menu của WinEdt. Do đó bạn nên theo
các chỉ dẫn về phương thức làm việc với các file giống như được mô tả trong phần 4.2 để hạn chế
vấn đề này.

4.3 Các file liên đới

Để có thể mở được một file của LaTeXPiX từ explorer bạn có thể liên kết file .lpx với LaTeXPiX.
Từ Settings→File Association (.lpx) để mở.

4.4 Tạo shortcut

Shortcut trên desktop và start menu có thể được tạo từ LaTeXPiX thông qua Settings→Desktop
Shortcut và Settings→Start Menu Shortcuts. Đối với start menu, có một file help ở dạng
pdf format được liên kết như là một shortcut, click vào đó để mở file help. Phiên bản cập nhật gần
nhất của LaTeXPiX sẽ có tài liệu hướng dẫn sử dụng bằng Tiếng Việt đính kèm.

4.5 Hỗ trợ WinEdt

Vài phụ trợ cho WinEdt được đưa ra để mở LaTeXPiX trong cửa sổ của LATEX editor nổi tiếng này.
Trong menu chính chọn Settings→WinEdt Additions để cài đặt một menu và một icon trên
thanh công cụ của WinEdt. Việc cài đặt các mục này được thực hiện một cách tự động bất kể
phiên bản nào của WinEdt cũng không ảnh hưởng đến thủ tục cài đặt mà LaTeXPiX đưa ra. Hãy
liên hệ với tác giả nếu bạn gặp vướng mắc khi cài đặt. Hình 4.1 là một screen shot của thanh công
cụ và menu chính trong WinEdt sau khi đã cài phụ trợ để mở LaTeXPiX.

Hình 4.1: Nút LaTeXPiX trên thanh công cụ của WinEdt

Nếu bạn có WinEdt 5.2 hoặc các phiên bản cũ hơn thì bạn sẽ phải xác định lại thư mục cài đặt khi
được yêu cầu. Đối với phiên bản WinEdt 5.3 hoặc các phiên bản mới hơn thì nó sẽ tự động thực
hiện việc này thay bạn. Không cần phải mở của sổ của WinEdt, nếu không có phần nào được tìm
thấy thì LaTeXPiX sẽ mở WinEdt cho bạn. Chú ý rằng khi bạn thấy hộp thoại nhắc bạn đăng ký sử
dụng WinEdt có nghĩa là việc cài đặt đã thất bại. Trong trường hợp này bạn nên khởi động WinEdt
trước khi cài đặt và tắt hộp thoại cảnh báo.

4.6 Mở file

Có nhiều cách để mở một file LaTeXPiX file (.lpx).
¥ Giao diện người dùng: Sử dụng File→Open và một hộp thoại sẽ được mở ra cho phép

bạn tìm đến file để mở.
¥ Explorer: Khi có một file với tên mở rộng là .lpx bạn có thể mở nó từ explorer. Explorer sẽ

thấy file .lpx và sẽ mở nó ra bằng LaTeXPiX. Khi LaTeXPiX đã được mở sẵn, khi bạn nhấp
chuột thì file này sẽ tự động tải vào của sổ LaTeXPiX.
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¥ Kéo & Thả: Từ explorer cũng có thể kéo một file .lpx rồi thả vào của sổ LaTeXPiX để mở nó.
Nếu file bạn kéo đã mở sẵn thì sẽ có một hộp thoại xuất hiện báo cho bạn biết file bạn chọn
đã được mở.

4.7 Lưu trữ file

Lần đầu tiên khi bạn lưu file bạn sẽ được hỏi để xác định tên file cũng như vị trí lưu trữ. Sau
lần lưu trữ đầu tiên này gọi là ”lưu trữ nóng” sẽ xác định tên file và vị trí lưu trữ, để lưu trữ nóng
một file bạn có thể chọn File→Save As từ "File menu" trong LaTeXPiX. Khi nhấp vào nút lưu
trữ trên thanh công cụ hoặc nhấn tổ hợp CTRL-S trên bàn phím thì lệnh lưu trữ sẽ được thực thi.

4.8 Trộn các file

Một hoặc nhiều file LaTeXPiX có thể được trộn với nhau bằng cách nhấp vào File→Merge. Trước
tiên một file nào đó phải được mở sẵn. Sau đó lệnh "merge" (hòa quyện (nghĩa đen)) sẽ được thực
hiện và bạn sẽ được hỏi để mở một file khác mà bạn muốn trộn với file hiện tại. Nhớ rằng sau khi
đã trộn file thì file mới là không xác định tên nhằm ngăn chặn những thay đổi ngoài ý muốn, hoặc
là file gốc bị ghi đè lên.

4.9 Chuyển đổi sang LATEX

Khi hình vẽ của bạn hoàn tất, bạn có thể chuyển nó sang mã nguồn LATEX. Bạn cũng có thể
chuyển hình vẽ sang mã nguồn LATEX và copy nó vào clipboard (SHIFT-.) hoặc đặt nó vào một
file (CTRL-.) mà bạn có thể chèn vào dùng lệnh \latexpix (xem phần 1.9). Bạn sẽ được hỏi để
xác định thư mục và tên file để xuất file chuyển đổi sang đó. Tên mở rộng mặc định của một file
output là .eepic hoặc .pgf, nếu file output đã tồn tại bạn sẽ được hỏi để xác nhận việc có ghi
đè lên file cũ hay không?

4.10 Lưu log file

Khi chế độ log được bật thông qua preferences menu, thì một log file được ghi lại để giúp bạn
chỉnh sửa lỗi. Trong menu chính chọn File→Save Log File để ghi lại nhật ký.
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Chương 5:
Điều chỉnh hình vẽ

Chương này sẽ đề cập đến việc một đối tượng được vẽ lên, dời vị trí, thay đổi kích thước, chỉnh sửa lại
và được chuyển sang LATEX code như thế nào.

5.1 Draw Mode (Kiểu vẽ)/ Edit Mode (Kiểu chỉnh sửa)

LaTeXPiX có hai phương thức được gọi là draw mode và edit mode. Hình ảnh được bắt đầu trong
draw mode, sau khi việc vẽ hình ảnh kết thúc thì bạn có thể chỉnh sửa lại hình ảnh cho vừa ý. Việc
chỉnh sửa hình ảnh được thực hiện trong edit mode. Có một số edit mode như sau:

¥ Edit [Move]: Các đối tượng có thể được di chuyển trong edit mode.
¥ Edit [Resize]: Các đối tượng có thể được chỉnh sửa lại kích thước bằng cách tịnh tiến các

điểm nút trên đối tượng.
¥ Edit [Select]: Các đối tượng có thể được chọn và sau khi chúng đã được chọn thì bạn có thể

phóng to thu nhỏ hay di dời hình ảnh.
¥ Edit [Extend Select]: Các đối tượng có thể được thêm vào một hình ảnh đã có sẵn, sau đó

có thể chỉnh sửa theo mong muốn.
¥ Edit [Area Select]: Các đối tượng nằm trong một khu vực nào đó có thể được chọn, sau khi

chọn xong có thể chỉnh sửa và di chuyển.

5.2 Các đối tượng vẽ

Một số lượng đa dạng các đối tượng có thể được vẽ lên. Nếu bạn muốn thêm một đối tượng nào
đó vào hình vẽ đang tạo thì bạn có thể chọn các đối tượng mong muốn từ menu chính (menu
Draw→ . . .), chọn nó từ panel nút hoặc dùng phím nóng. Nó sẽ được hiện ra trong thanh trạng
thái loại đối tượng nào mà bạn đã chọn. Hơn thế nữa nó còn cho biết các nút hay các phím có thể
sử dụng được trong khi bạn vẽ hình ảnh. Hầu như khi nào phím chuột trái cũng cho phép chúng
ta đánh dấu điểm đầu tiên, và click chuột phải để hủy bỏ đối tượng vừa vẽ. Theo mặc định thì con
trỏ chuột sẽ được chuyển đến một điểm cắt nào đó giữa hai đường ngang và dọc trên nền vẽ (Đây
cũng chính là hạn chế rất xấu của LaTeXPiX làm cho người dùng rất khó chịu và mỏi tay và nếu
như bạn không thích dùng tính năng mặc định này bạn có thể bỏ chọn trong Preferences menu.
Ấn phím Shift trong khi chuyển con trỏ sẽ cho phép bạn di chuyển chuột một cách tự do, và
khi buông phím Shift thì tính năng gắn trỏ chuột vào các điểm cắt lại được bật lên (nền vẽ của
LaTeXPiX là một tờ giấy dùng để vẽ đồ thị).

Click lên một điểm đã chọn trên nền vẽ bạn có thể xác định các điểm vẽ. Tùy thuộc vào đối tượng
bạn muốn vẽ mà có thể bạn phải xác định một hay nhiều điểm trên nền vẽ. Sau khi bạn đã xác
định được các điểm yêu cầu thì đối tượng sẽ được hoàn tất trên nền vẽ, sau đó bạn cũng có thể
bắt đầu một đối tượng khác theo kiểu vừa chọn. Nếu bạn muốn bỏ hình đang vẽ hoặc muốn vẽ lại
một đối tượng khác thì bạn có thể click chuột phải hay nhấn phím ESC. Khi bạn làm việc này thì
LaTeXPiX sẽ tự động chuyển sang chế độ edit mode.
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5.3 Chọn / Gộp nhóm các đối tượng

Bạn có thể chọn một đối tượng đơn bằng các nhấp chuột vào bounding box của đối tượng
(bounding box là một hình chữ nhật hay hình vuông được LaTeXPiX tính toán và xuất hiện xung
quanh đối tượng khi nó được chọn, nếu ở chế độ edit mode và left mouse click). Nếu cú click chuột
trái rơi trên nhiều đối tượng thì LaTeXPiX sẽ tính toán xem đối tượng nào gần trỏ chuột vừa click
nhất. Khi một đối tượng được chọn thì nó sẽ được sơn màu đỏ xung quanh. Việc chọn đối tượng
có thể được mở rộng (hay gộp thành nhóm) bằng việc nhấn giữ phím Ctrl trong khi click lên các
đối tượng. Nếu một đối tượng đã chọn nằm trong nhóm thì khi bạn nhấp chuột lên nó sẽ bị loại
ra khỏi nhóm. Việc gộp các đối tượng vào nhóm cũng có thể thực hiện bằng cách nhấn giữ phím
Shift vào kéo trỏ chuột thành một hình chữ nhật bao trùm lên các đối tượng bạn muốn chọn,
sau đó nhả chuột trái ra nhưng vẫn giữ phím Shift thì mỗi đối tượng nằm trong hình chữ nhật sẽ
có một bounding box màu đỏ xác định đối tượng đã được chọn. Nếu muốn bỏ chọn các đối tượng
nằm trong hình chữ nhật bạn vừa kéo thì chỉ việc nhấn giữ phím Shift và kéo một hình chữ nhật
trên vùng không có đối tượng nào tồn tại. Bạn cũng có thể chọn tất cả các đối tượng bằng menu
Edit→Select All tương đương với việc nhấn tổ hợp phím CTRL+A.

5.4 Kiến tạo các Instances

Một instance là một nhóm cố định bao gồm các đối tượng được vẽ trong LaTeXPiX mà chúng có
thể được lưu vào một file với mục đích có thể tái sử dụng nhóm đối tượng cố định này khi cần
thiết. Cũng có thể xảy ra trường hợp đối với instance rằng bạn phải vẽ một “sơ đồ logic số” có
chứa các cổng AND, OR hoặc INV. Bạn có thể vẽ một cổng AND trong LaTeXPiX và lưu các đối
tượng tạo nên cổng AND vào một instance file. Sau này khi bạn muốn vẽ sơ đồ điện tử nào có các
cổng AND, OR hoặc INV bạn chỉ việc lôi chúng ra rồi thả vào sơ đồ mới, việc tạo file instance này
sẽ giúp bạn tiết kiệm được nhiều thời gian và công sức. Để lưu hình đang vẽ thành một instance
file bạn đi tới Drawing Library→Save Instance File. Lúc này bạn sẽ được hỏi để đặt tên
cho file mới. Để chèn một instance vào hình đang vẽ làm như sau: Drawing Library→Load
Instance File.

5.5 Di chuyển các đối tượng

Khi bạn đã vẽ các đối tượng bạn có thể dịch chuyển chúng đến bất cứ điểm nào trên nền vẽ
(canvas). Để có thể di chuyển được chúng bạn phải chọn một hay nhiều đối tượng (xem phần 5.3).
Di chuyển các đối tượng có thể thực hiện bằng một hoặc nhiều cách sau đây:

¥ Kéo & Thả chuột: Sau khi đã chọn xong các đối tượng bạn có thể giữ chuột trái rồi kéo các
đối tượng đến nơi mong muốn sau đó thả chuột. Chú ý rằng các đối tượng sẽ được đính vào
các điểm cắt của các đường xác định tọa độ trên nền vẽ, bằng việc nhấn giữ phím Shift
trong khi di chuyển chúng, sẽ giúp bạn điều chỉnh vị trí của các đối tượng một các tự do
hơn. Chú ý rằng bạn chọn đối tượng trước sau đó nhấn phím Shift rồi nhấp chuột để kéo
nếu không LaTeXPiX sẽ tự động chuyển sang chế độ ’Edit [Area Select]’ mode. Khi bạn đã
buông chuột trái thì các đối tượng sẽ bị khóa lại muốn di chuyển các đối tượng này thêm lần
nữa thì bạn phải thực hiện lại các thủ tục di chuyển như trên. Trong suốt quá trình di chuyển
bạn có thể thấy đường đi của nhóm được chọn.

¥ Keyboard: Khi các đối tượng đã được chọn thì chúng có thể chuyển động đều nếu như bạn
nhấn giữ các phím mũi tên lên, xuống, trái, phải trên keyboard. Khi bạn nhấn các phím
này thì nhóm chọn sẽ di chuyển 1 khoảng bằng cạnh của một ô vuông trên nền vẽ. Khi bạn
nhấn giữ phím Shift trong khi dùng các mũi tên để di chuyển đối tượng thì chúng sẽ dịch
chuyển một point theo nền vẽ (một point = 1

72 × 2.54 cm) thay vì quét một vệt. Khi hình chữ
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nhật xuất hiện lúc bạn bắt đầu di chuyển các đối tượng đến vị trí mong muốn sau đó nhấn
Enter để định vị chúng.

5.6 Điều chỉnh kích thước các đối tượng

Hầu hết các đối tượng được LaTeXPiX tạo ra cũng có thể điều chỉnh kích thước sau khi vẽ xong.
Danh sách các đối tượng dưới đây không thể điều chỉnh kích thước.

¥ Các đường chấm chấm
¥ Các vector
¥ Văn bản (nhưng các framebox có thể điều chỉnh)
¥ Các Instance (instance là nhóm đối tượng cố định)

Mỗi lần chỉ có thể điều chỉnh kích thước cho một đối tượng duy nhất. Nếu bạn chọn một đối tượng
bạn sẽ thấy một hình vuông bao xung quanh đối tượng cho phép bạn điều chỉnh kích thước. Khi
sử dụng bàn phím để điều chỉnh kích thước các đối tượng bạn phải nhấp chuột trái lên hình vuông
ngay tại điểm mà bạn muốn điều chỉnh. Sau đó nhấp giữ chuột trái vài lần để bỏ ra, bạn sẽ thấy
rằng tại điểm mà bạn muốn điều chỉnh kích thước của đối tượng thì hình vuông nho nhỏ sẽ được
tô màu kín. Bây giờ thì bạn có thể điều chỉnh chúng bằng cách nhấn giữ phím Ctrl và dùng các
phím mũi tên để điều khiển; lên, xuống, trái, phải. Mỗi lần nhấn phím điều khiển thì đối tượng
sẽ bị quét một vệt đơn. Khi nhấn phím tổ hợp phím Shift và Ctrl bạn có thể di chuyển góc
trên thân của đối tượng một point trên nền vẽ. Khi đã hài lòng với kết quả bạn thấy thì nhấn phím
Enter.

Điều chỉnh kích thước đối tượng với sự giúp đỡ của chuột bạn làm như sau: Trước hết bạn phải
nhấp chuột lên hình vuông tại điểm bạn muốn điều chỉnh, giữ chuột và rê theo hướng mong muốn
để điều chỉnh hình vuông tô đỏ tại điểm đó. Chú ý rằng khi bạn không nhấn giữ phím Shift thì tỉ
lệ của đối tượng sẽ đi theo các điểm cắt đồ thị trên nền vẽ, khi đã có được kích thước mong muốn
bạn thả chuột để kết thúc.

Trên Preferences menu bạn có thể xác lập thời gian mà bạn phải nhấp và giữ chuột trái trên hình
vuông tô màu đỏ ấy nơi bạn muốn điều chỉnh. Việc hạn chế thời gian này sẽ giúp bạn chỉ việc
nhấp chuột trái trong khoảng thời gian nhất định rồi buông ngón trỏ và rê chuột để di chuyển điểm
cần điều chỉnh sau đó nhấp chuột để buông tha đối tượng khi kết thúc.

Tỉ lệ cố định cũng có thể được thiết lập khi điều chỉnh kích thước đối tượng. Điều này rất có lợi, ví dụ
như: các hình ảnh nhập từ bên ngoài vào sẽ giữ được độ phân giải và độ trong sáng của hình ảnh
khi mà tỉ thể điều chỉnh được giữ cố định. Để bật tính năng này bạn vào Settings→Maintain
object aspect ratio và đánh dấu bật lên ở chế độ “on”. cũng có thể bật nhanh dùng phím
F11.

5.7 Copy các đối tượng vào Clipboard

Sau khi đã chọn một hay nhiều đối tượng nhấn tổ hợp phím CTRL-C để copy các đối tượng vào
clipboard. Một thuận lợi khi copy các đối tượng vào clipboard là có thể paste chúng vào một hình
vẽ mới hoặc khi vẽ các đối tượng giống nhau bạn chỉ cần copy mà không cần phải vẽ lại tốn thời
gian.
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5.8 Paste các đối tượng từ Clipboard

Sau khi các đối tượng đã được copy vào clipboard bạn có thể paste chúng vào một cửa sổ mới
hoặc thêm hình vẽ khác bằng cách nhấn tổ hợp phím CTRL-V. Khi paste các đối tượng vào một
hình vẽ mới thì các đối tượng vừa paste sẽ tự động đổi thành màu đỏ có nghĩa là bạn có thể resize
hoặc move các đối tượng này.

5.9 Nhân đôi các đối tượng

Sau khi một hay nhiều đối tượng được chọn nhấn Ins để copy các đối tượng. Các đối tượng sẽ
được nhân bản thêm một hình mới tương tự nằm cạnh hình gốc (lý do trừu tượng), một offset mặc
định sẽ được áp dụng lên đối tượng vừa mới được nhân bản và hình mới sẽ tự động được chọn.

5.10 Xóa bỏ các đối tượng

Khi một hay nhiều đối tượng được chọn bạn có thể xóa bỏ chúng khỏi nhóm bằng cách nhấn phím
del. Bạn sẽ được hỏi để xác định xem bạn có chắc bạn muốn xóa các đối tượng không cần thiết
hay không? chức năng hỏi này được bật thông qua menu preferences.

5.11 Quay các đối tượng

Một số đối tượng có thể được quay với một góc 90 ◦ cùng chiều hoặc ngược chiều kim đồng hồ.
Đây cũng là một vấn đề mở mà tác giả đang làm việc và chưa hoàn thành.

5.12 Đưa đối tượng ra trước/sau

Bạn có thể gửi một đối tượng ra phía trước một đối tượng khác, trước hết bạn chọn một đối tượng
cần gửi sau đó nhấn PgUp/PgDn để gửi đối tượng ra phía trước/sau một đối tượng khác.

5.13 Vẽ lại tất cả các đối tượng

Có thể xảy ra trường hợp các đối tượng ngẫu nhiên nào đó không hiển thị như mong muốn khi
bạn mở lại một file đã vẽ trước đó, điều này có thể là do Window đã không được refresh lại lúc đó.
Trong trường hợp này, LaTeXPiX có thể vẽ lại tất cả các đối tượng. Nhớ rằng refresh tất cả các đối
tượng sẽ được tự động thực hiện nhưng cũng có trường hợp hình vẽ tự cập nhật nhưng nền vẽ
không đủ chứa. Muốn refresh lại các đối tượng nhấn phím F12.

5.14 Biên dịch lại LaTeXPiX script

Phiên bản mới của LaTeXPiX có thể có các cải tiến về script được dùng để lưu trữ các đối tượng
của hình vẽ. Khi bạn mở một hình vẽ được tạo bằng các phiên bản cũ hơn thì có thể xảy ra trường
hợp script phải được chuyển đổi để đáp ứng những yêu cầu của phiên phản mới mà bạn đang
dùng. Việc chuyển đổi sang script của phiên bản mới hơn, tự động được LaTeXPiX thực hiện,
nhưng bạn cần ra lệnh để kết thúc quá trình chuyển đổi bằng cách nhấn tổ hợp phím CTRL-\.
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5.15 Tìm kiếm & xóa các đối tượng không cần thiết

Có thể xảy ra trường hợp một đối tượng nào đó mà bạn vừa vẽ xong với LaTeXPiX nhưng
trông không đẹp mắt. Ví dụ như, khi hai đối tượng với cùng tính chất đặt chồng lên nhau mà
chúng ta không thấy. Những đối tượng không cần thiết này có thể tìm và xóa bằng cách chọn
Edit→Search &Delete Redundant Objects.

5.16 Áp dụng các tính năng nổi bật cho đa giác/ hình spline

Các đa giác hay các hình spline đóng có thể được mở ra (và ngược lại) bởi việc chọn hình đa giác
hay hình spline và nhấn phím BackSpace. Tương tự khi bạn chọn các điểm trên hình đa giác hay
hình spline và xóa đi các góc thích hợp bằng cách nhấn tổ hợp Ctrl–Del.

5.17 Xem kết quả biên dịch

Để có thể xem được kết quả hình vẽ bằng LaTeXPiX của bạn sau khi biên dịch bạn có thể
xem chúng dưới hai dạng DVI và PDF. DVI có thể xem bằng các công cụ như YAP hay WinDVI
còn PDF có thể dùng PDF Foxit, Adobe Acrobat Reader. . .
Khi xem một file LATEX đã được xử lý, với chương trình xem DVI thì màu có thể không xuất hiện,
các dòng chữ được quay có thể vẫn nằm ngang, các đối tượng có bóng đổ sẽ không có bóng màu
xám. Hình 5.1 sẽ cho thấy kết quả khi xem hình vẽ 1.3 với chương trình YAP xem file DVI:

Hình 5.1: Giao diện của YAP khi xem hình 1.3

Nhưng khi chuyển file DVI sang file PDF thì những hạn chế này tự động biến mất. Kết quả khi xem
với chương trình đọc PDF có thể xem trong hình 5.2:
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Hình 5.2: Giao diện của Acrobat Reader khi xem hình 1.3

Khi một file PDF được mở sẵn trước đó thì chương trình sẽ tự động đóng nó khi biên dịch ra kết
quả mới.
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Chương 6:
Thiết lập cấu hình cho chương trình

6.1 Thiết lập đơn vị đo cục bộ

Trên mỗi pixel trong hình vẽ bằng LaTeXPiX sẽ được biên dịch vào một độ dài nào đó trong LATEX
được gọi là \unitlength. Bằng việc giảm \unitlength bạn sẽ thu được một hình vẽ với kích
cỡ nhỏ hơn, và nếu bạn tăng \unitlength bạn sẽ có hình vẽ lớn hơn. Đối với mỗi hình vẽ bằng
LaTeXPiX bạn có thể thiết lập tỉ lệ về độ lớn của hình vẽ trong menu local unitlength, xem hình 6.1.
Menu này có thể tìm thấy qua Settings→Set Local\unitlength.

Hình 6.1: Menu đơn vị đo cục bộ

6.2 Font chữ trong LaTeXPiX GUI (Graphic User Interface)

Menu này cho phép bạn thay đổi font hiển thị cho giao diện của LaTeXPiX. Ví dụ như, một font
không chuẩn của Window có thể được chọn cùng với một tập các chuỗi kí tự khác. Việc lựa chọn
để thay đổi font cho giao diện của LaTeXPiX thường được đưa ra cho bạn lựa chọn vì các ngôn
ngữ như: tiếng Trung Quốc, Nhật Bản, Hàn Quốc. . . không dùng các font chuẩn của Window.
Việc chọn font chữ cho giao diện được thực hiện bằng bước sau Settings→Global Font
Settings. Hình 6.2 cho thấy giao diện của menu chọn lựa font. Để kích hoạt menu lựa chọn font
bạn phải đánh dấu chọn "Use User Fonts For GUI" trong preferences menu. Xem phần 6.3 để
biết thêm.

Hình 6.2: Menu lựa chọn font giao diện cho LaTeXPiX
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6.3 Preferences

Trong Preferences menu (xem hình 1.2) bạn có thể thiết lập được nhiều tính năng
và các lựa chọn cho LaTeXPiX. Bạn có thể mở menu này qua menu chính như sau:
Settings→Preferences hoặc qua ion trên panel công cụ. Bạn có thể xem giao diện của
Preferences menu trên hình 1.2
Các thiết lập được đưa ra là:

¥ Con trỏ chỉ tới các nút tọa độ trong quá trình vẽ: Theo mặc định tất cả các điểm vẽ đều
được định vị chỉ tới các nút tọa độ trên nền vẽ nếu như bạn không nhấn phím Shift. Nếu tính
năng này được bật thì con trỏ chuột sẽ có xu hướng dính với các nút tọa độ khi bạn rê chuột
trên nền vẽ.

¥ Khoảng thời gian con trỏ chuột chỉ vào các nút tọa độ: Con trỏ chuột có hướng chỉ
tới các nút tọa độ trong khoảng thời gian xác định ở đây. Và khoảng thời gian xác định này
có thể được đặt nhỏ đến mili-giây. Nếu máy tính của bạn xử lý chậm thì nên đặt giá trị cho
khoảng này thấp thôi.

¥ Trỏ chuột / Điều chỉnh thời gian: Các đối tượng riêng lẽ có thể được chọn bằng cách
click vào bounding box của chúng. Khi một đối tượng được di chuyển với sự hỗ trợ của trỏ
chuột thì chúng ta cũng phải click lên bounding box của chúng sau đó thả đến vị trí mong
muốn. Để ngăn chặn những di chuyển ngoài ý muốn, khi chọn cho từng đối tượng riêng lẽ
một khoảng thời gian nào đó thì chuột trái phải được nhấn và giữ trong một khoảng thời gian
nhất định trước khi có thể di chuyển đối tượng. Nên chỉ việc di chuyển trỏ chuột lên và xuống
một cách nhanh chóng để lựa chọn đối tượng, và nhấn giữ chuột trong một khoảng thời gian
nhất định bạn sẽ có thể di chuyển được đối tượng đã được lựa chọn. Khoảng thời gian có
thể thiết đặt được hiển thị bằng mili-giây.

¥ Khoảng cách giữa các nút tọa độ trên nền vẽ: Khoảng cách giữa hai điểm tọa độ có thể
điều chỉnh được trong Preferences menu và giá trị được biểu diễn bằng số pixel ngang, dọc
giữa hai điểm nút.

¥ Bán kính mặc định cho hình oval: Khi vẽ hình oval, thì các góc sẽ được uốn tròn bằng việc
đặt các phần tư đường tròn vào các góc của hình chữ nhật. Ở đây bán kính của các phần tư
đường tròn có thể điều chỉnh.

¥ Các điểm chấm mặc định/Khoảng các giữa các gạch nối: Khoảng cách mặc định của
các khoảng trắng giữa các đường chấm chấm hay đường gạch nối có thể điều chỉnh được.
Người dùng Windows 9x/Me không thể nhìn thấy sự khác biệt giữa đường chấm chấm và
đường gạch nối trong hình vẽ của LaTeXPiX, xem 1.6 để biết thêm về vấn đề này.

¥ Kích cỡ font chữ: Kích thước font chữ dùng cho văn bản trong hình vẽ của bạn (Không
phải là font chữ dùng cho interface) có thể hiệu chỉnh được nhưng không vượt quá giới hạn
về kích cỡ font mặc định dùng trong LATEX là 10, 11, 12pt.

¥ Đơn vị chiều dài mặc định(unitlength): Giá trị mặc định của unitlength có thể thay đổi
thông qua cửa sổ dùng để thiết lập giá trị cho unitlength xem 6.1 để biết thêm.

¥ Ngôn ngữ: Ở đây ngôn ngữ cho user interface (Giao diện người dùng) cũng có thể tùy chọn
được. Nếu bạn muốn dịch LaTeXPiX sang ngôn ngữ của nước bạn thì hãy liên hệ với tác giả.

¥ Font chữ trên nền vẽ: Tên của font chữ dùng trong hình vẽ của bạn cũng có thể được
chọn. Bạn có thể thiết lập font chữ mặc định theo LATEX để đoán được kết quả biên dịch sẽ
trông giống như trong hình vẽ trên giao diện của LaTeXPiX. Chú ý rằng, tuy nhiên font chữ
đó sẽ không được dùng khi xem kết quả với dạng DVI và PDF nếu như LATEX font được dùng.

¥ Đường dẫn của hình ảnh: Khi bạn đính kèm file hình ảnh vào tài liệu thì LATEX cần biết nơi
để truy vấn hình ảnh. Thư mục mặc định để truy xuất hình ảnh là thư mục chứa file nguồn
.tex. Nếu bạn lưu trữ các hình ảnh cần chèn vào một thư mục con để dọn dẹp thư mục gốc
trông gọn gàng hơn, thì bạn phải thông báo đường dẫn cho LATEX biết.
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¥ Lưu / Tải / Chuyển đổi các thư mục: Đây là những thư mục vừa được chọn cho những
hộp thoại lưu và tải file khác nhau. Để có thể bắt đầu với các hộp thoại này thì LaTeXPiX sẽ
luôn mở các hộp thoại đã thiết lập khi bạn muốn đính kèm file hoặc lưu file. Chúng sẽ được
tự động điều chỉnh khi khi tài liệu di chuyển đến một thư mục mới khi bạn tải file, lưu phải
hay chuyển đổi định dạng file.

¥ Tự động lưu file: File LaTeXPiX script được lưu tự động khi bạn đánh dấu chọn chức năng
autosave box. File mà bạn đang làm việc sẽ được tự động lưu lại cứ sau mỗi khoảng thời
gian mà LaTeXPiX đã qui định, thời gian giữa hai lần tự động lưu được tính bằng phút.

¥ Thu nhỏ LaTeXPiX vào khay hệ thống: Đánh dấu chức nằng này nếu bạn muốn thu nhỏ
LaTeXPiX vào khay hệ thống thay vị chỉ thu nhỏ bình thường xuống taskbark.

¥ Tạo các file .bak: Khi lưu file bạn vừa hoàn thành thì một file dự phòng sẽ được tạo ra
cho lần lưu trữ trước đó, khi mà tính năng này được bật. File dự phòng sẽ có tên mở rộng là
.bak và có thể phục hồi lại qua menu: File→Restore old saved file (.bak).

¥ Hiển thị tên của hình ảnh: Khi chèn hình ảnh vào nền vẽ của LaTeXPiX thì vị trí của hình
ảnh có thể được hiển thị ở phía bên trên góc trái của hình ảnh.

¥ Hiển thị các điểm chấm đều trên nền vẽ thay vì các đường kẻ đan lưới(grid): Nếu bạn
muốn có nền vẽ là các grid điểm chấm thay vì là các đường kẻ đậm thì bạn nên bật chức
năng này. Nhưng chú ý rằng nền điểm chấm sẽ làm cho bạn mất thời gian lâu hơn một chút
để vẽ do đó đã làm chậm quá trình vẽ hình.

¥ Thẩm định các lựa chọn: Nhiều thiết đặt có thể được tạo và sau đó có một thông điệp sẽ
hỏi bạn xem bạn có chắc chắn muốn chọn chúng hay chưa. Nếu bạn không muốn các thông
điệp này xuất hiện mỗi lần bạn thay đổi các setting nào đó thì bạn có thể bỏ chọn chức năng
này thông qua Preferences menu.

¥ Hỏi khi lưu: Khi được kích hoạt, một thông điệp sẽ xuất hiện hỏi bạn có lưu file đang
làm việc trước khi đóng cửa sổ LaTeXPiX. Câu hỏi này chỉ xuất hiện khi một hình vẽ
mới, đã được chỉnh sửa nhưng chưa được lưu.

¥ Cảnh báo khi xóa đối tượng: Khi được kích hoạt, LaTeXPiX sẽ hỏi bạn để xác nhận
rằng bạn có chắc xóa đối tượng hoặc một nhóm đối tượng đã được chọn trước đó.

¥ Xác nhận để tạo một file mới: Khi được kích hoạt LaTeXPiX sẽ hỏi bạn về hành động
mà bạn muốn tiến hành tạo một file mới hoặc xóa file đã chọn.

¥ Xác nhận khi thoát LaTeXPiX: Khi được kích hoạt bạn sẽ được hỏi khi thoát chương
trình, nếu bạn chắc chắn muốn thoát thì click “Yes" nếu không thì click “No”.

¥ Xác nhận ghi đè lên file đã chyển mã trước đó: Khi một hình vẽ LaTeXPiX được chuyển
đổi qua mã của LATEX và lưu file vào một file mà bạn có thể đặt tên cho file output đã
chuyển đổi. Nếu file LATEX nguồn có cùng tên thì bạn sẽ được thông báo là tên file bạn
định lưu đã tồn tại và bạn có muốn thay thế nó hay không, thông báo này sẽ xuất hiện
khi chức năng này được bật. Nếu bạn không muốn nhìn thấy cảnh báo này thì chỉ việc
bỏ chọn trong Preferences menu.

¥ Tự động tạo file.bb cho hình ảnh: Các hình ảnh cần có một boundingbox file (.bb file) để
xác nhận các chiều của hình ảnh trong LATEX. Những file này được tạo ra bằng các gói chuẩn
như ebb.exe , gói này được cung cấp cùng với gói lệnh dvitopdfm. Những bounding box
file này được tạo ra một cách tự động và cũng được tự cập nhật khi hình ảnh được chèn từ
bên ngoài và được edit lại trong LaTeXPiX.

¥ Dùng User Fonts For GUI: Khi được bật, font được chọn trong menu "GUI Font" của
LaTeXPiX. Hãy xem phần 6.2 nếu bạn chưa đọc phần này. Khi đặt lựa chọn này ở chế độ
tắt sang bật thì GUI fonts được áp dụng ngay lập tức, nhưng khi chế độ này từ bật sang tắt
thì bạn cần khởi động lại chương trình để dùng kiểu font gốc của Windows.

¥ Check For An Update Upon Startup: Kiểm tra phiên bản mới xem có được cập nhật hay
chưa. LaTeXPiX sẽ thực hiện việc kiểm tra này khi chức năng này được kích hoạt, nếu bạn
tắt chức năng này thì bạn phải kiểm tra thủ công.
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¥ Nhật ký: Lựa chọn này sẽ cho phép chương trình ghi lại các thông điệp như được hiển thị
trên thanh trạng thái. Tất cả các thông điệp này được lưu lại cho mục đích chỉnh sửa lỗi.

¥ Pha trộn kiểu Alpha (chỉ trong NT): Mức độ trong suốt của toàn bộ các ứng dụng có thể
được thiết đặt bằng cách dịch chuyển con chạy trên thanh điều chỉnh nằm bên phải ô lựa
chọn chức năng này. Khi bạn không muốn bật chế độ trong suốt thì bỏ chọn nó để làm cho
quá trình vẽ hình ảnh nhanh chóng hơn vì bạn nhìn thấy các nét vẽ rõ hơn. Chú ý rằng chức
năng này chỉ có hiệu lực khi bạn chạy LaTeXPiX trên môi trường Windows NT/2000/XP.
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Chương 7:
Những cải tiến trong tương lai

Những mục liệt kê dưới đây đang được phát triển và vẫn chưa được lồng vào trong LaTeXPiX :
¥ Hỗ trợ tốt hơn về thước đo trên nền vẽ.
¥ Các chức năng edit tọa độ cao cấp.
¥ Hỗ trợ hoàn toàn gói lệnh PGF.
¥ Lưu vị trí của cửa sổ và chức năng “hoàn nguyên” vị trí khi khởi động lại chương trình.
¥ Cung và các đường cong Bezier với mũi tên ở cuối.
¥ Có thể chèn thêm các hình ảnh ngoài các loại phổ biến (JPEG,PNG) như WMF và PostScript.
¥ Khả năng phủ màu các hình chữ nhật, hình tròn, hình đa giác với các đối tượng như: các

đường ngang, dọc, đường chéo. . .
¥ Phủ màu các framebox và màu này sẽ khác với màu của văn bản nhập vào, đây là một ứng

dụng độc lập từ việc phủ màu framebox như là một tham số.
¥ Tự động rào framebox bằng đường vẽ biên.
¥ Thêm vào các fancy box giống như là ứng dụng của gói lệnh fancybox.sty
¥ Gộp thành nhóm các đối tượng.
¥ Chức năng thu phóng hình ảnh.
¥ Giao diện với YAP. Khi click lên một hình vẽ trong giao diện của YAP thì hình vẽ sẽ tự động

mở ra bằng LaTeXPiX.
¥ Nhiều chức năng giao diện với WinEdt.
¥ Khi khởi động từ explorer, thiết lập thư mục chuyển mã đến thư mục nơi mà mà bạn double

click(nhấp đôi để mở file, cách phổ biến của các ứng dụng chạy trên Windows) lên file thay
vì phải lưu file vào một thư mục mặc định của LaTeXPiX.

¥ Cho phép các đường dẫn quan hệ khi bạn muốn đính kèm hình ảnh vào nền vẽ của
LaTeXPiX. Khi bạn muốn chèn một hình ảnh khác vào thì chương trình sẽ tự động mở
lại thư mục bạn vừa mở để lấy hình ảnh lần trước.

¥ Lựa chọn để cho thư mục chứa file kết quả biên dịch tự động xóa khi thoát LaTeXPiX hoặc
sau khi xem xong kết quả.

¥ Đưa ra công thức cho hình vẽ spline trong khi đó vẫn có một một sự khác biệt giữa hình vẽ
nhìn thấy trong LaTeXPiX và khi nó đã được biên dịch sang DVI.

¥ Hỗ trợ quay hình ảnh tốt hơn cho tất cả các đối tượng ứng dụng.

Hãy cho tác giả biết những điều cần được chỉnh sửa hay cải tiến hoặc thêm vào những tính năng
mới chưa có trong LaTeXPiX để chúng tôi có những điều chỉnh nhằm giúp người dùng sử dụng
phần mềm này một cách thuận tiện và có hiệu quả hơn.
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Chương 8:
Đăng ký sử dụng LaTeXPiX & Biên dịch
sang các ngôn ngữ khác

Bạn có thể đăng ký để sử dụng LaTeXPiX miễn phí. Chương này sẽ cho bạn biết thủ tục đăng ký.

8.1 Yêu cầu mã kích hoạt chương trình

Bạn có thể đăng ký sử dụng LaTeXPiX miễn phí, nhưng chỉ đối với người dùng sử dụng cho mục
đích phi lợi nhuận !, bằng cách gửi email đến cho tác giả hoặc gửi email đến cho Huỳnh Thị Tuyết
Vân tại dienbaquanlovenico@yahoo.ca nếu bạn không thích viết thư bằng tiếng Anh cho tác giả
người Hà Lan này. Bạn sẽ nhận được thông tin đăng ký sử dụng LaTeXPiX qua email mà chúng tôi
nhận được. Còn nếu bạn muốn mua LaTeXPiX để sử dụng cho mục đích thương mại hoặc muốn
tài trợ cho dự án LaTeXPiX thì hãy liên hệ với tác giả.
Chú ý rằng đối với bản chưa đăng ký thì bạn vẫn có thể sử dụng được tất cả các chức năng
của LaTeXPiX nhưng khi chuyển sang mã của LATEX thì nếu hình vẽ của bạn chứa hơn 10 đối
tượng lúc đó chương trình sẽ không cho phép bạn chuyển đổi, khi đăng kí xong thì chức năng
hạn chế này sẽ được loại bỏ. Khi đã có số đăng ký bạn có thể nhập thông qua menu như sau:
Help→Generate Registration Request Number lúc này sẽ có một screen xuất hiện chứa
số “required number” giống như trong hình 8.1.

Hình 8.1: Cửa sổ đăng ký của chương trình

Nếu bạn đã cài LaTeXPiX lên thiết bị SCSI thì sẽ không thể lấy được số đăng ký yêu cầu, bạn phải
cài LaTeXPiX trên thiết bị IDE, ngược lại chương trình sẽ treo khi bạn cố mở cửa sổ key Generator.
Điều bạn cần làm là gửi một email có chứa các thông tin theo yêu cầu sau:

¥ Generated Registry key: (Số lấy từ registry) Số này có thể lấy trong LaTeXPiX thông qua
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Help→Generate Registration Request Number trên menu chính. Số này sẽ là một
số có 8 chữ số (ví dụ: 98427842).

¥ Name (tên): Tên của bạn, tên này có thể dài hơn 30 kí tự, ví dụ như: “Hoa Hoc Viet Nam”
Những thông tin phụ trợ khác (không thật sự cần thiết cho quá trình đăng ký) như nghề nghiệp
của bạn. . .

¥ Địa chỉ email: Thông tin đăng kí sẽ được gửi vào địa chỉ email mà bạn đã gửi để yêu cầu
nhận được thông tin từ tác giả, nếu như bạn không cung cấp một địa chỉ email nào khác
kèm theo thì chúng tôi chỉ còn cách là reply email của.

¥ Các chú thích: Bạn thích hay không thích LaTeXPiX ở điểm nào.
¥ Những cải tiến có thể cho LaTeXPiX: Thậm chí chỉ là một thay đổi nho nhỏ nào đó hoặc

những sở thích cá nhân của riêng bạn, mọi nhận xét luôn được tiếp nhận một cách niềm nở.
¥ Những thông tin khác: Một số thông tin về bạn, đất nước bạn đang sống và làm việc,

tại sao bạn muốn dùng LaTeXPiX hoặc những gói dùng để vẽ mà bạn đã dùng trước đây.
Những thông tin này sẽ giúp chúng tôi biết được mục đích sử dụng phần mềm này của bạn.

Hãy gửi những thông tin cần thiết đến tác giả qua beurden@email.com . Tác giả sẽ sớm trả lời
thư của bạn một cách nhanh nhất có thể, nhưng nếu tác giả bận quá thì bạn hãy ráng đợi chút
xíu nhé. Nếu như bạn đợi lâu quá, thì hãy vui lòng gửi lại email cũ, bởi vì có thể hộp mail của anh
Buerden đã đầy, hoặc bị down không rõ lý do. Hãy yên tâm bạn sẽ nhận được thông tin đăng ký
để sử dụng LaTeXPiX.

8.2 Cập nhật & Registry Keys

Khi bạn cài đặt một phiên bản mới của LaTeXPiX và sau khi bạn đã đăng ký bạn sẽ không cần
một mã kích hoạt nào khác. Mã kích hoạt chương trình mà bạn nhận được sẽ tương thích với
phiên bản mới của LaTeXPiX. Nếu thủ tục đăng ký thay đổi tôi sẽ thông báo đến người dùng
và bạn sẽ đăng ký lại. Phiên bản ổn định và mới vừa phát hành bạn có thể tìm thấy trên CTAN
server: http://www.ctan.org/tex-archive/systems/win32/latexpix/ Khi bạn vào Help→Check For
An Update thì chương trình sẽ tự động kiểm tra xem phiên bản mới đã được cập nhật hay chưa,
nếu có bản mới chương trình sẽ hỏi bạn có muốn tải phiên bản mới hay không, nếu bạn đồng ý
thì chương trình sẽ dẫn bạn đến CTAN để tải.

8.3 Biên dịch sang các ngôn ngữ khác

Bạn có thể dịch LaTeXPiX sang ngôn ngữ của nước bạn nhằm giúp người dùng sử dụng chương
trình một cách dễ dàng hơn, LaTeXPiX đã được dịch sang một số ngôn ngữ nhưng các ngôn ngữ
khác rất được hoan nghênh để thêm vào. Nếu bạn muốn đóng góp bản dịch của mình thì hãy email
cho tác giả, trong thời gian tôi dịch quyển sách hướng dẫn nhỏ này, thì giao diện của LaTeXPiX
chưa được dịch sang tiếng Việt, bạn có thể làm điều này để giúp những sinh viên mới tiếp xúc với
LATEX dễ dàng để học TEX hơn. Trước đây thì tác giả cung cấp luôn bộ công cụ biên dịch nhưng
sau này các công cụ này chỉ gửi đi đến những ai có yêu cầu.

8.4 Những người dùng đã đăng ký sử dụng

Khi bạn đã đăng ký sử dụng LaTeXPiX thì tên của bạn sẽ được thêm vào danh sách ở bảng B.1
hay bảng B.2. Xem phụ lục B để biết thêm thông tin.
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Chương 9:
Lịch sử của chương trình & Các bug đã
phát hiện

Phiên bản gần đây nhất của LaTeXPiX có thể tìm thấy trên server của CTAN tại
http://www.ctan.org/tex-archive/systems/win32/latexpix/ . Trong chương này một danh sách sẽ được
đưa ra để bạn thấy những thay đổi trong quá trình phát triển các phiên bản của LaTeXPiX, và
chương này cũng cung cấp cho bạn những thông tin cần thiết cho các người dùng đã làm quen với
chương trình để thấy những gì đã được thay đổi.

9.1 Các bug đã phát hiện

Do tác giả quá bận với công việc tại công ty nên vẫn chưa có thời gian để tạo một bảng thông báo
về các bug đã được tác giả cùng với người dùng phát hiện.

9.2 Lịch sử của LaTeXPiX

CTAN_19 bugfix 1 đã phát hành với những cải tiến như sau:
¥ Khi mở hoặc merge1 các file nếu nền vẽ được phóng lớn thì các file tải vào không như

ý muốn thường phát sinh lỗi hoặc treo chương trình. Những thông báo này nhận được từ
Robert Rutten.

¥ Khi không có đối tượng nào được chọn, giữ chuột trái và kéo con trỏ sẽ cho phép bạn chọn
một lúc nhiều đối tượng.

CTAN_19 đã phát hành với những cải tiến được liệt kê dưới đây:
¥ Chức năng thu phóng (sử dụng phím + và –). Chọn , di chuyển, điều chỉnh kích thước và vẽ

các đối tượng ở vị trí đã phóng lớn hoặc thu nhỏ nếu có thể.
¥ Mở/đóng hình đa giác/hình spline cũng có thể áp dụng được trên các đối tượng khác, và sinh

ra những hiệu ứng rất lạ.
¥ Offset của thanh cuộn ngang và dọc sinh ra việc đánh dấu khi xem lại hình vẽ không đúng

khi di chuyển hình spline.
¥ Logfile được lưu tự động khi chế độ tự ghi lại logfile được bật trong Preferences menu.
¥ Chương trình bị treo, ô dùng gõ văn bản khi được đóng bằng icon dấu chéo (Nút chéo dùng

đóng các của sổ của nhiều ứng dụng chạy trên hệ điều hành Windows) trên giao diện trên
Windows.

¥ Chức năng chỉnh sửa nhanh hình oval đã được thêm vào.
¥ Xuất hiện box lạ điều chỉnh kích thước, được báo lỗi bởi Robert Rutten.
¥ Số hàng hiển thị khi xem trên viewer đối với script và các file đã chuyển đổi..
¥ Các tọa độ có thể thay đổi (thông qua edit coordinates) đã không được hiển thị trên màn

hình nếu như không được refresh lại. Báo lỗi bởi Steven Harrod.
¥ Mở và xem log file chứa lỗi.

1merge file có nghĩa là bạn gộp 2 hay nhiều file lại với nhau ví dụ như trong MS. Exel bạn merge 4 cell có nghĩa là bạn gộp 4
cell thành 1 cell, còn cell là gì thì bạn chắc đã biết
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CTAN_18 được phát hành với những cải tiến như sau:
¥ Chức năng “Save file as” không làm việc theo ý muốn.
¥ Cắt giảm dung lượng file cài đặt bởi bỏ bớt phần ngôn ngữ và editor của ngôn ngữ, lược bớt

phần ví dụ.
¥ chức năng hỗ trợ PGF cho việc chèn hình ảnh được thêm vào.
¥ Giữ được tỉ lệ cố định khi resize lại hình vẽ. Chức năng này có thể bật hoặc tắt bằng phím

tắt F11. Không có một tỉ lệ cụ thể nào được mặc định.

CTAN_17 được phát hành với các cải tiến:
¥ Hỗ trợ PGF cho hình elip và hình tròn: trơn (trống không tô màu, không đổ bóng), đổ bóng

và phủ màu.
¥ Hỗ trợ đặt icon của LaTeXPiX trên giao diện của “WinEdt 5.40”.
¥ Loại bỏ lỗi khi xem với EEPIC. Hình elip và hình tròn phủ màu, trước đây luôn là màu đen.

CTAN_16 được phát hành với các cải tiến:
¥ Di chuyển thanh cuộn từ menu chính đã không thành công và chức năng con lăn trên chuột

để di chuyển thanh cuộn dọc theo nền vẽ được thêm vào.
¥ Xem hình vẽ PGF trong PDFLATEX đã hoàn chỉnh.
¥ Thêm các tính năng hỗ trợ PGF: trơn/đổ bóng/hình đa giác phủ màu, đường cong Bezier và

mũi tên.
¥ Điều chỉnh tọa độ trên các đối tượng đơn dùng tổ hợp phím (Ctrl+F1).
¥ Icon trên thanh công cụ giúp bạn có thể chuyển đổi đơn vị đo lường từ “inch” sang “cm” và

ngược lại.
¥ Thêm chức năng ghi lại logfile của quá trình biên dịch.

CTAN_15 bugfix 2 được phát hành với những cải tiên dưới đây:
¥ Offset của thanh cuộn ngang và dọc gây nên sự dịch chuyển của các hình vẽ đã chuyển mã.

Bug được phát hiện bởi Robert Rutten.
¥ Di chuyển bounding box của văn bản gây nên sự lệnh lạc về tọa độ của đối tượng. Đối tượng

mới sẽ có cùng tọa độ với đối tượng cũ. Bug được phát hiện bởi Robert Rutten.

CTAN_15 bugfix 1 được phát hành với các cải tiến như nhau:
¥ Chiều của hình ảnh khi được chuyển sang EEPIC và PGF đã không đúng.
¥ Thêm một số chính năng hỗ trợ chuyển đổi sang PGF: màu hay xám, hiện đã được hỗ trợ

đầy đủ. Chuyển đổi hình chữ nhật, hình vuông, hình elip: trơn/đổ bóng/phủ màu. Chuyển đổi
văn bản thuần túy, đường thẳng thuần túy.

CTAN_15 được phát hành với các cải tiến như sau:
¥ Viết lại toàn bộ cơ sở dữ liệu cục bộ để lưu trữ các đối tượng cho phép vẽ và chỉnh sửa các

đối tượng nhanh hơn và tốn ít bộ nhớ hơn. Xin gửi lời cảm ơn đến Robert Rutten về việc thử
nghiệm và sửa lỗi.

¥ Chức năng output sang PGF cũng được thêm vào, mặc dù tính năng này vẫn chưa ổn định.
Chỉ thêm vào vì mục đích demo thử nghiệm chứ chưa được áp dụng thường xuyên.

¥ EEPIC output được chuyển qua phần mở rộng là .eepic thay vì .out. Hình vẽ dạng PGF
cũng sẽ có phần mở rộng .pgf. Hơn bao giờ hết sự thay đổi này đã được thực hiện bởi vì
phần tên mở rộng .out đã có thể chèn vào file nguồn dành cho LATEX.

¥ “Undo” nhiều tầng cho phép bạn dễ dàng chỉnh sửa hình vẽ của mình, khi bạn không vừa ý,
bạn có thể lùi lại bản vẽ lần trước để chỉnh sửa.

¥ Tất cả các đối tượng có thể được chọn bằng tổ hợp phím nóng CTRL+A. Các mũi tên cũng
đã được sử dụng phương pháp này để chọn chúng nhưng với một tổ hợp phím nóng khác
Ctrl + W.
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¥ Phát hiện các bug không cần thiết kém ổn định như mẫu của ống kính phóng to thu nhỏ.
Các lỗi đã được phát hiện và những tính năng không khả thi như dạng thu phóng văn bản,
instance và chống phân mảnh bộ nhớ.

¥ Khi xem file PDF output, sẽ đóng các tài liệu đang mở bằng acrobat reader. File output PDF
khi được cập nhật, thì file output mới sẽ không thể ghi đè lên file cùng tên mà bạn đang mở
khi dùng các phiên bản trước đây của LaTeXPiX. Bởi vì khi file đã được mở trong Acrobat
Reader nó chỉ ở trạng thái đọc được chứ không gi đè lên được.

¥ Thước đo được thêm vào hỗ trợ các đơn vị đo inch và centimetres, khoảng cách giữa các
grid có thể thay đổi được từ grid chính trên nền vẽ.

¥ Một vài chức năng trong menu Preferences không được lưu trữ và Robert Rutten đã giúp tìm
ra chúng.

¥ Chương trình bị treo khi đăng kí, cảm ơn nhiều người dùng đã chỉ ra điều này.
¥ Đặt đơn vị đo lên đến 0.254 bởi vì trong EEPIC 1inch= 2.54cm do đó chọn 0.254mm.
¥ Tính năng hiển thị chương trình ở chế độ trong suốt trên hệ điều hành Windows NT.
¥ Sử dụng mẫu MDI để tạo nền vẽ, có thể bật tắt các thanh công cụ và đưa ra nhiều chức

năng hoạt động ổn định của giao diện người dùng.
¥ Sử dụng chế độ màu cơ bản RGB (Red-Green-Blue) thay vì dùng gam màu CMYK. Việc này

sẽ ngăn những chuyển mã không cần thiết và làm cho kết quả output chính xác hơn.
¥ Lựa chọn để con trỏ chuột có xu hướng đính vào các nút tọa độ trên nền vẽ mà không buộc

con trỏ chuột phải định vị trên đó.
¥ Log file cũng được lưu cùng với những thông điệp trên thanh trạng thái nhằm cho mục đích

sửa lỗi.

CTAN_14 bugfix 1 được phát hành với những cải tiến như sau:
¥ Loại bỏ một số bug từ text editor và có đề cập đến nhiều dòng trong editor. Những hàng

trắng chỉ là một hàng để trống hiện sẽ tự động loại bỏ, chức năng năng này cũng tương tự
như chức năng tự động loại bỏ khoảng trắng của LATEX.

¥ Loại bỏ bug chính yếu trong việc dán từ clipboard.

CTAN_14 được phát hành với những cải tiến như sau:
¥ Module tiếng Đức được dịch bởi Lars Borchert được thêm vào.
¥ Làm giảm gram màu không cần thiết để chuyển đổi RGB sang CMYK một cách chính xác

cho tất cả các màu.
¥ Lược bớt nhiều bug trong text editor và có thể nhập caption (nhãn của hình ảnh, cũng có thể

hiểu caption, là một lời chú giải cho hình ảnh).
¥ Hy vọng rằng việc sửa lỗi sẽ liên tục được cập nhật thường xuyên.

CTAN_13 được phát hành với những cải tiến như sau:
¥ Framebox nhiều dòng hiện đã có thể áp dụng được mặc dù ngắt đường kẻ vẫn chưa được

áp dụng trong LaTeXPiX.
¥ Thông tin đăng ký có thể nhập vào bằng tay.

CTAN_12 được phát hành với các cải tiến như sau:
¥ Sửa lỗi trong text editor . Khi nhấn phím BackSpace trong khi gõ văn bản vào editor thì

LaTeXPiX sẽ bị treo.
¥ Đặt một icon của LaTeXPiX vào thanh trạng thái của WinEdt hiện đã được đề cập.
¥ Sửa lỗi để LaTeXPiX tự động cập nhật khi khởi động chương trình. Bạn có thể tắt chức năng

này thông qua Preferences menu.

CTAN_11 được phát hành với những cải tiến như sau:
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¥ Chức năng xóa các điểm trên hình đa giác và hình spline.
¥ Chức năng preview (xem lại) có thể xóa được từ menu chính.
¥ Vẽ các đối tượng mới có thể được tiến hành mà không có các đường vẽ chấm chấm, và có

thể nhìn thấy được rõ ràng.
¥ Cung tròn đã được thêm vào chương trình.

CTAN_10 bugfix 2 được phát hành với các cải tiến như sau:
¥ Sau khi đã điều chỉnh kích thước và vẽ hình của các đối tượng mới không thực hiện như theo

ý muốn thì các lỗi đã được loại bỏ.
¥ Thêm thông điệp khi cố gắng mở 2 instance của LaTeXPiX.

CTAN_10 bugfix 1 được phát hành với các cải tiến như sau:
¥ Số điểm chấm trên hình đa giác/hình spline như đã nói được tăng lên nhưng thực tế thì chỉ

có 10 là có thể. Bug này cũng bị loại trừ.
¥ Webupdate bị treo bởi vì chương trình muốn thực hiện ngay tức thì sau khi khởi động mà

chưa được đồng bộ hóa.
¥ Chức năng tự động kiểm tra phiên bản cập nhật sau khi chương trình khởi động xong được

thêm vào, cho đến phiên bản hiện nay, mặc bạn vừa download xong sau khi cài đặt xong rồi
reboot lại computer bạn sau đó khởi động tiếp LaTeXPiX nhưng bạn sẽ vẫn được thông báo
LaTeXPiX đã có phiên bản mới bạn có cập nhật hay không?. Chức năng tự động kiểm tra
phiên bản mới bạn có thể tắt chế độ này thông qua Preferences menu.

¥ Loại bỏ tips help từ help menu.
¥ Thêm một mục nhỏ về GUI font trong sách hướng dẫn sử dụng.

CTAN_10 được phát hành với các cải tiến như sau:
¥ Các hình đa giác và hình spline được mở bằng cách chọn điểm cuối và nhấn tổ hợp phím
Ctrl + Backspace và nhấn phím Backspace để khép các hình vẽ.

¥ Sửa lỗi cho bộ máy vẽ hình.
¥ Sửa lỗi khi kiểm tra nếu các đối tượng không thể nhìn thấy trên nền vẽ.

CTAN_9 được phát hành với các cải tiến như sau:
¥ Thủ tục mới cho việc vẽ và hiệu chỉnh kích cỡ hình vuông, hình tròn một cách dễ dàng hơn

và tiện lợi hơn.
¥ Sửa lỗi trong text editor khi nhập vào môi trường văn bản ’[’ và ’]’.
¥ Bounding box được hiển thị khi hình ảnh được chèn vào trên nền vẽ.
¥ Điểm đầu/điểm cuối của hình đa giác và hình spline đóng không thể chọn được.
¥ Đỉnh trên hình đa giác và hình spline đã tăng lên con số 50.
¥ Sửa lỗi khi chuyển mã các cung tròn. LaTeXPiX treo chương trình trong quá trình chuyển mã

hoặc xem kết quả biên dịch.
¥ Một tỉ lệ màu xám 100% về việc phủ màu đối tượng và border. Điều này được thực hiện đúng

khi thiết lập tỉ lệ màu xám lên đến 99% để chuyển qua mã LATEX.
¥ Module tiếng Nhật và tiếng Ba Lan được thêm vào.
¥ LaTeXPiX GUI font có thể thay đổi được, điều này được ứng dụng để giải quyết vấn đề với

một số ngôn ngữ có các hệ kí tự đặc biệt như: Tiếng Trung Quốc, Tiếng Nhật và Hàn Quốc.
¥ Loại bỏ một số bug và cải tiến chức năng xem kết quả biên dịch.
¥ Khi chuyển đổi mã của hình vẽ sang LATEX và lưu chúng lại dưới dạng tên mở rộng .out bạn

sẽ được hỏi có ghi đè lên nếu một file có cùng tên, cùng thuộc tính đã tồn tại trong cùng một
thư mục lưu trữ với file bạn muốn tạo hay chưa? Chức năng thẩm định trước khi ghi đè lên
file có sẵn có thể đặt ở chế độ tắt thông qua menu Preferences.
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¥ Cảnh báo nếu bạn đặt đối tượng ra ngoài khu vực của nền vẽ hoặc không nằm trong miền
khả kiến của nó hay có một phần nào đó của hình vẽ nằm ngoài nền vẽ.

CTAN_8 bug fix được phát hành với các cải tiến như sau:
¥ Trên các hệ điều hành Windows 95/98/ME LaTeXPiX hay bị lỗi chạy không ổn định vì nó

không lấy được “registry value”. Việc lấy “registry value” đã được bỏ ra khỏi chương trình và
chờ đến khi tìm được một giải pháp khả thi.

¥ Tất cả các lựa chọn trong Preferences menu đều được lưu trong registry thay vì trong một
.set.

¥ Thêm chức năng đọc file đã biên dịch ở dạng PDF.
¥ Có thể thiết đặt một đường dẫn cho bộ máy biên dịch, mở file sau khi biên dịch ở dạng DVI

và chuyển file dạng DVI sang PDF. Trong những trường hợp như thế này, giả sử rằng bạn
dùng “latex.exe”, “yap.exe” và “dvitopdfm.exe”. Những file này phải được xác định đường dẫn
cụ thể trong Windows. Nếu như chương trình vẫn không thực hiện việc biên dịch file nguồn
thì bạn phải xem lại xem đường dẫn bạn cung cấp có đúng với đường dẫn của bộ biên dịch
trong máy tính của bạn hay chưa.

¥ Thêm lệnh copy và paste vào clipboard.

CTAN_8 phát hành với các cải tiến như dưới đây:
¥ Bán kính hình oval có thể điều chỉnh theo mong muốn.
¥ Các instance có thể lưu và dùng lại được. Chúng đóng vai trò là các nhóm đối tượng. Một

số đối tượng có thể được lưu vào một instance file (.lpxi) và có thể được chèn vào giống như
là các đối tượng đơn trong hình vẽ của bạn. Ví dụ: Hai cổng input AND hoàn chỉnh có thể
được vẽ một lần, lưu vào một instance file và bạn có thể tái sử dụng nhiều lần để tạo một sơ
đồ logic trong hình vẽ của mình.

¥ Một số lựa chọn mới trong Preferences menu được thêm vào.
¥ Bao gồm cả các hình ảnh dạng bitmap (*.bmp) không được hỗ trợ nữa do dạng bitmap không

được hỗ trợ hoàn chỉnh trong LATEX.
¥ Một số cải thiện về vẽ các cung và việc chuyển đổi mã.
¥ Quay các framebox văn bản trong khoảng −360 ◦ ↔ 360 ◦
¥ Di chuyển, điều chỉnh kích cỡ và vẽ các đối tượng được mặc định để đính vào các đầu nút

tọa độ của nền vẽ, và nhấn phím Shift để vô hiệu hoá tính năng này, để vẽ tự do.
¥ Bộ kiểm tra trên trang web các ứng dụng được cập nhật. Nếu có một phiên bản mới hơn

được tải lên CTAN thì chương trình của bạn hỏi xem bạn có muốn tải bản mới hay không?
¥ Viết thêm vào những chú thích chủ yếu vào sách hướng dẫn, việc này vẫn chưa hoàn thành

nhưng có tiến bộ và rõ ràng hơn những lần trước.
¥ Việc dịch LaTeXPiX sang các ngôn ngữ khác được thêm vào, nếu bạn muốn dịch sang ngôn

ngữ của bạn hãy cho tôi biết nhé. Xem sách hướng dẫn để biết thêm chi tiết.
¥ Văn bản đã có kiểu in đậm nghiêng.

CTAN_7 bugfix được phát hành với những cải tiến như sau:
¥ Lỗi khi mở của sổ “number of Bezier poitns” để mở rộng hình vẽ.

CTAN_7 phát hành với những cải tiến như sau:
¥ Thay đổi sự tách biệt của các dấu chấm để nhìn thấy được.
¥ Cảnh báo khi ghi đè lên file chuyển đổi có sẵn được loại bỏ.
¥ Thêm địa chỉ web và email vào cửa sổ thông tin về chương trình.
¥ Bản này có thể hiệu chỉnh số điểm trên đường cong Bezier.
¥ Thay đổi một số phím nóng mặc định.
¥ Thêm một số icon vào cửa sổ công cụ vẽ.
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¥ Thiết lập cho văn bản và framebox có thể thay đổi được cho nhiều đối tượng được lựa chọn.
¥ Loại bỏ các lỗi khi dùng drawpanel (nơi có chứa các icon của công cụ vẽ), tạo file mới, quay,

xoá đối tượng, chuyển đổi bitmap.

CTAN_6 được phát hành với các cải tiến như sau:
¥ Các file ngôn ngữ và file nguồn của sách hướng dẫn sẽ không được phân phối cùng với

phiên bản mới, nếu bạn muốn xem những file này thì hãy liên hệ với tác giả.
¥ Lỗi visual được loại bỏ cho việc vẽ hình oval.
¥ Đã có lỗi khi di chuyển các điểm chấm.
¥ Lỗi chủ yếu khi chỉnh sửa các đối tượng đã được loại bỏ.
¥ Thủ tục về mức độ đổ bóng của hình vẽ được thay đổi, do đó một phiên bản script mới là

cần thiết.
¥ Các đối tượng sẽ được loại ra khỏi nhóm khi chúng đã được chọn và nằm sẵn trong nhóm.
¥ Các hình elip trơn dạng đường chấm chấm, oval và cung đã có thể vẽ được. Đây không phải

là trường hợp của LATEX do đó những hạn chế đã được đưa vào LaTeXPiX.
¥ Khi chọn một ngôn ngữ nào đó từ Preferences menu, có thể áp dụng và có hiệu lực ngay.

Trong những phiên bản cũ hơn thì trước hết bạn phải chọn ngôn ngữ và đóng Preferences
menu để lệnh thay đổi này được thực thi. Bạn có thể đọc các thiết lập bằng ngôn ngữ bạn
chọn mà không phải đóng và mở lại Preferences menu.

¥ Cải thiện việc vẽ các cung tốt hơn nhưng vẫn chưa hoàn toàn đúng.

CTAN_5 được phát hành với những cải tiến như dưới đây:
¥ Chức năng xem kết quả khi biên dịch sang mã LATEX được thêm vào, và có thể xem kết quả

hình vẽ ở dạng DVI.
¥ Xuất hiện thông điệp cảnh báo khi file không thể đọc hoặc lưu vào.
¥ Có lỗi xuất hiện khi chuyển đổi vector.
¥ Câu hỏi được đưa ra khi bạn đặt tên file quá dài, nếu như tính năng này được đặt ở chế độ

off trong registry. Tên file dài là cần thiết để xác nhận cú pháp đúng tên file khi click một .lpx
file từ explorer.

¥ Sửa lỗi cho việc quay framebox. Nếu framebox của văn bản mà không quay khi bạn xem kết
quả của hình vẽ, thì gói rotating.sty phải được nạp vào. Lỗi này đã được sửa bây giờ bạn
không cần gói lệnh rotating.sty nữa.

¥ Sữa lỗi cho việc canh phải văn bản trong framebox.
¥ Thỉnh thoảng icon nhỏ của chương trình không hiển thị trên taskbar.
¥ Hình đa giác đóng không đúng, thực hiện chức năng không ổn định.
¥ Xem kết quả của hình chữ nhật và hình vuông sẽ xuất hiện lỗi nhỏ.
¥ Những đối tượng riêng lẽ có thể được thêm vào nhóm chọn, sau đó di chuyển, copy và xoá

bỏ. Thủ tục chọn, chỉnh sửa, di chuyển và copy đã được tối ưu, hạn chế các lỗi và cải thiện
quá trình thực hiện các công việc trên.

¥ Sửa một số lỗi cho việc chèn hình ảnh, chỉnh sửa và xem kết quả.

CTAN_4 được phát hành với các cải tiến như sau:
¥ Một panel được thêm vào phía bên trái trong cửa sổ của chương trình với các icon để chọn

nhanh các công cụ và quản lý file. Dấu panel này bằng cách nhấn phím F8.
¥ Thêm vào chức năng tự động lưu với một sự điều chỉnh cục bộ có thể được thiết lập thông

qua Preferences menu.
¥ Loại bỏ một số lỗi khi lưu và chuyển mã hình vuông, hình tròn.
¥ Khi thiết lập các lựa chọn cho đường vẽ như: màu, đầu mũi tên hay tỉ lệ màu xám, nhìn

chung những thiết lập này sẽ không đúng sau khi đối tượng được chỉnh sửa.
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¥ Mũi tên không thể điều chỉnh kích cỡ được như ý theo phía của đầu mũi tên. Khi mũi tên
được điều chỉnh kích cỡ hay di chuyển thì đầu mũi tên sẽ không di chuyển theo.

¥ Nếu muốn xoá nhiều đối tượng khi bạn chọn một lúc nhiều đối tượng thì chương trình không
xoá chúng một cách suôn sẻ.

¥ Chữ in nghiêng và in đậm không hiển thị khi chuyển sang mã LATEX và biên dịch bởi vì có lỗi
trong việc quay framebox.

¥ LaTeXPiX được đặt lên phía trước của các cửa sổ khác khi một file .lpx được nhấp đúp.
Tải các file có tên dài sẽ được chương trình ghi nhớ.

¥ Thư mục để tải, lưu và chuyển mã bây giờ có thể chọn được thông qua Preferences menu.
¥ Thỉnh thoảng chương trình vẫn giữ nguyên hình chữ nhật , hình xuất hiện khi bạn kéo con

trỏ chuột để chọn đối tượng, thậm chí sau khi đã đóng chương trình hoặc không ở trong chế
độ sẵn sàng để vẽ hình. Lỗi này đã được sửa.

¥ Nhìn chung khoảng cách cục bộ đối với các đường chấm chấm hay đường đứt nét có thể
xác định được. Khoảng cách giữa các đối tượng sẽ được đưa vào chương trình trong tương
lai không xa.

¥ Thêm một số kiểu mũi tên mới.
¥ Khi văn bản được nhập vào có chứa dấu ngoặc [ hoặc] thì có lỗi xuất hiện bởi vì

LaTeXPiX Script file cũng dùng dấu ngoặc. Vấn đề này sẽ được giải quyết bởi việc thêm
vào script file chứa tham số độ dài văn bản để xử lý.

¥ Phân biệt giữa đường chấm chấm và đường đứt nét có thể được xác định và điều chỉnh.

CTAN_3 được phát hành với những cải tiến như sau:
¥ Một vài phiên bản của“colordvi.sty” làm cho hình vẽ được tạo với LaTeXPiX có thể chuyển

mã. Và việc này đã được hiểu chỉnh, gói “colordvi.sty” không cần thiết nữa.
¥ Đính kèm “build number” trong hộp thoại about về phiên bản hiện tại bạn đang dùng.
¥ Vector và mũi tên không hiển thị đúng.
¥ Nền vẽ có thể hiệu chỉnh kích cỡ, di chuyển và có thể thiết lập được sang dạng full screen.

Và chức năng đính trỏ chuột vào nút toạ độ thể hiện không đúng trong những phiên bản
trước, khi thay đổi khoảng cách các nút trên nền vẽ.

¥ Những cải tiến cơ bản về việc hiệu chỉnh kích thước của cái đối tượng điểm.
¥ Tối ưu tính năng di chuyển đối tượng.
¥ Thêm một khoảng thời gian chờ có thể điều chỉnh, nhằm hạn chế những di chuyển không

mong muốn đối với các đối tượng. Trong một khoảng thời gian nhất định nào đó thì đối tượng
sẽ không di chuyển sau một lần click chuột kế đó.

¥ Các thư mục để tải, lưu, và chuyển mã có thể chọn thông qua Preferences menu. Và chúng
sẽ được mặc định cho lần khởi động kế tiếp của LaTeXPiX và không có thư mục nào chưa
được định rõ.

¥ Hỗ trợ tốt hơn cho việc quay framebox. Gói lệnh rotation.sty sẽ được dùng, loại bỏ lựa chọn
quay đối với văn bản trơn (Không có các hiệu ứng trên văn bản), “rotation.sty” sẽ được dùng
thay vì “rotate.sty” như trong các phiên bản trước của LaTeXPiX.

¥ Thay thế tất cả các phiên bản của các style file đã bị hack bằng các phiên bản gốc của
chúng. Cho nên bạn có thể chọn để chèn các file style từ bản phân phối LATEX của bạn.
Điều này không có gì khác so với phiên bản đã hack, và chúng nên được thay thế bằng các
phương pháp khác thay vì hack các style file đã có ngoại trừ các style file như “curves.sty”!!!

CTAN_2 được phát hành với các cải tiến như sau:
¥ Không thể vẽ, chuyển mã, copy hay paste được các hình đa giác hoặc có thể chỉnh sửa theo

đúng cách.
¥ Hỗ trợ các ngôn ngữ khác, và thêm một số công cụ để giúp cho việc biên dịch sang các

ngôn ngữ khác một cách dễ dàng hơn.
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¥ Biên dịch sang Catalan menu chính và một vài chỗ được dịch sang tiếng Tây Ban Nha.
¥ Cửa sổ thông điệp xuất hiện ở tâm của giao diện.
¥ Chức năng thu phóng chỉ áp dụng được trên nền vẽ.
¥ Hình chữ nhật visual (hình chữ nhật mờ) khi chọn nhiều đối tượng và tính năng chọn nhiều

đối tượng cùng lúc cũng được hỗ trợ tốt hơn.
¥ Khi tổ hợp file thì sinh ra lỗi.
¥ Màu kết hợp RGB có thể dùng được thay vì phải sử dụng những màu đã định nghĩa trước

đó.
¥ Paste một đối tượng khi không có cái nào tồn tại trong clipboard thì phát sinh lỗi.
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Phụ lục A:
Phím nóng sử dụng trong LaTeXPiX

Dưới đây là danh sách “tổ hợp các phím nóng” có thể dùng với LaTeXPiX nhưng những chỉ dẫn
này có đôi khi không được cập nhật đầy đủ để phù hợp với các phiên bản mới mà bạn đang sử
dụng:

Tổ hợp phím Chức năng của chúng

Insert
Copy & paste các đối tượng
đang được chọn

Del Xoá đối tượng đang được chọn

Esc
Huỷ đối tượng vừa vẽ
(chuyển về edit mode)

PgUp Di chuyển nền vẽ lên một ô trên nền vẽ
PgDn Di chuyển nền vẽ xuống một ô trên nền vẽ
Home Di chuyển nền vẽ lên đầu trang
End Di chuyển nền vẽ xuống cuối trang

BackSpace
Tự động khép kín hình đa giác
hoặc hình spline

F1 Mở file giúp đỡ dạng pdf
F2 Chọn màu
F3 Chọn tỉ lệ xám
F4 Chọn đầu mũi tên
F5 Chọn các lựa chọn của đường vẽ
F6 Chọn các lựa chọn cho văn bản
F7 Chọn các lựa chọn cho hình ảnh
F8 Chọn các lựa chọn cho hình oval
F9 Các lựa chọn về Bezier

F10
Bật, tắt chức năng preview của
hình ảnh

F11 Giữ tỉ lệ cố định
F12 Vẽ lại tất cả các đối tượng
Ctrl-F1 Hiệu chỉnh toạ độ
Ctrl-F2 Hiệu chỉnh màu sắc
Ctrl-F3 Hiệu chỉnh tỉ lệ màu xám
Ctrl-F4 Hiệu chỉnh đầu mũi tên
Ctrl-F5 Hiệu chỉnh các lựa chọn cho nét vẽ
Ctrl-F6 Hiệu chỉnh lựa chọn văn bản
Ctrl-F7 Chỉnh sửa hình ảnh
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Ctrl-F8 Hiệu chỉnh các lựa chọn cho hình oval
Ctrl-F9 Hiệu chỉnh lựa chọn Bezier
Ctrl-A Vẽ mũi tên trơn
Ctrl-B Vẽ đường cong Bezier trơn
Ctrl-D Vẽ điểm trơn
Ctrl-F Vẽ framebox trơn
Ctrl-I Vẽ đường tròn trơn
Ctrl-J Chèn hình ảnh JPG/PNG
Ctrl-L Vẽ nét trơn
Ctrl-M Vẽ vector trơn
Ctrl-N Vẽ hình spilne trơn
Ctrl-O Vẽ hình oval trơn
Ctrl-P Vẽ hình đa giác trơn
Ctrl-Q Vẽ hình vuông trơn
Ctrl-R Vẽ hình chữ nhật trơn
Ctrl-S Lưu file
Ctrl-V Paste các đối tượng đã được copy
Ctrl-X Vẽ cung trơn
Ctrl-Z Hoàn nguyên về trạng thái cũ
Ctrl-Tab Tìm đối tượng
Ctrl-PgUp Gửi đối tượng được chọn ra phía trước
Ctrl-PgDn Gửi đối tượng được chọn ra phia sau

Ctrl-Del
Xoá điểm đã chọn trên
hình đa giác/spline

Ctrl-BackSpace
Thiết lập điểm cuối cho
hình đa giác/spilne và để mở

Ctrl-. Chuyển mã LATEX và lưu hình vẽ
Ctrl-/ Xem PDF output
Alt-F4 Thoát LaTeXPiX
Alt-D Vẽ điểm chấm đổ bóng
Alt-E Vẽ elip đổ bóng
Alt-I Vẽ hình tròn đổ bóng
Alt-N Vẽ hình spline đổ bóng
Alt-P Vẽ đa giác đổ bóng
Alt-Q Vẽ hình vuông đổ bóng
Alt-R Vẽ hình chữ nhật đổ bóng
Shift-D Vẽ điểm có phủ màu
Shift-E Vẽ elip phủ màu
Shift-I Vẽ hình tròn phủ màu
Shift-N Vẽ hình spilne phủ màu

23 tháng 1 năm 2006 N.J.H.M. van Beurden and Vietnamese by Thái Phú Khánh Hòa



Phụ lục A: Phím nóng sử dụng trong LaTeXPiX 55

Shift-P Vẽ hình đa giác phủ màu
Shift-Q Vẽ hình vuông phủ màu
Shift-R Vẽ hình chữ nhật phủ màu
Shift-. Chuyển sang mã LATEX & copy
Shift-/ Xem YAP output
Shift-PgUp Di chuyển nền vẽ sang trái 1 ô trên nền vẽ
Shift-PgDn Di chuyển nền vẽ sang phải 1 ô trên nền vẽ
Shift-Home Di chuyển nền vẽ sang trái
Shift-End Di chuyển nền vẽ sang phải

Bảng A.1: Các phím nóng
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Phụ lục B:
Các user đã đăng ký

Bảng B.1 đến B.4 sẽ liệt kê sơ bộ các user đã đăng ký sử dụng LaTeXPiX. Tác giả sẽ thường
xuyên cập nhật phần này. Nếu bạn chưa có tên thì đừng ngại đăng ký với tác giả, còn việc phần
mềm này là open source nhưng tại sao phải đăng ký thì bạn nên liên hệ với tác giả sẽ biết câu trả
lời xác đáng.

Đăng ký # Tên Đăng ký # Tên
001 Ignacio Peñarrocha Alos 002 A.J.A. Rutten
003 Jörn Gruber 004 Masashi Nosaka
005 Renato Basso 006 Viswanath Padmanabhan
007 Joseph Hilferty 008 Brian Davey
009 Anatoliy Malyarenko 010 Charles B. Cameron
011 Jean-Marie Beckers 012 Nguyễn Thái Sơn
013 Karim Bajestani 014 Manfred Beer
015 George Radutsky 016 Vasiliy Sklyarenko
017 Guy Laroque 018 Jan Rubak
019 Stefan Maus 020 John Hillas
021 Jason T.H. Lee 022 Deng Ke
023 Anders Åslund 024 Bayron A. Delgado
025 Marina L. Logares 026 Tim Alderson
027 Corneliu Sochichiu 028 Rosy Atmadja
029 Patsis N. Panagiotis 030 Benjamin Hinrichs
031 Edmundo A. Marques F. 032 Felipe Lora
033 Miguel Hernandez 034 Daniel Nash
035 Daniele Giorgio Degiorgi 036 Qi Yan
037 Bernd Dettmer 038 Robert Rohrkemper
039 Javier Fuentes 040 Mohamed Sobrani
041 Erwin Bruning 042 Claudio Jose Struchiner
043 Annette de Meij 044 Aref Meddeb
045 Alexander Bukhvalov 046 Cheng Lei
047 René van der Heijden 048 Claus Greiber
049 Ratael Torres 050 Henk Kelderman
051 Falko Fecht 052 Pascal Lando
053 Mamoun Gadir 054 Eduardo Costa
055 Eric Leclercq 056 Juan Antonio Vera Lopez
057 Stefan Mecke 058 Daniel Badenhorst

Bảng B.1: Các user đã đăng ký (phần 1)
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Đăng ký # Tên Đăng ký # Tên
059 David Pluntze 060 Jorge Cobb
061 Nikolay V. Redko 062 Ronald Fischer
063 Dirk Smits 064 Janos Fodor
065 Ryszard Walentynski 066 Teck Wong Soon
067 Peter Dahms 068 Luis González
069 Alexander Sellerholm 070 Daniel Olaru
071 Lena-Luisa Heß 072 Giuseppe De Arcangelis
073 Karsten K. Krueger 074 Arba Minch
075 Rob Tinch 076 Qing Zhang
077 Atique Malik 078 Sigvald Hansen
079 Toh Wee Teck 080 Gail Rosen
081 Martynas Manstavicius 082 W.R. Johnstone
083 Marcel Neitsch 084 Jason R. Lewis
085 Peter Zimmermann 086 Todor Todorov
087 Cristian Neculaescu 088 Juliana Doshkova
089 Zhao Jiayi 090 Giorgio Fazio
091 Imran Nyazee 092 António Caleiro
093 Omar Seawolf 094 Gert Tamberg
095 Albert Troesch 096 Fabrice Collard
097 Benno Bucher 098 Vaquero F. P. Agustí
099 Steve Vanlanduit 100 Fernando Bastos
101 Dimitri Jeltsema 102 Yanjun Wen
103 Nicolas Marchand 104 Constantin Trushkin
105 R. Ermers 106 Ahmad Khayyat
107 ATK Slawek 108 Haysam I. Dahman
109 Ryan Aycock 110 Peter Rupert
111 Paul Klein 112 Abdelali El Aroudi
113 Hendri Adriaens 114 Milan Sykora
115 Peter Skirka 116 Ignasi Furió
117 Danie Els 118 Arupratan Daripa
119 Janusz Kawczak 120 Adam Kumiszcza
121 Rohit Trivedi 122 Blaz Kmetec
123 Katarina Roskar 124 Bernard Salanie
125 Manfred Kirschhock 126 Rudy Prabowo
127 Alois Krähenmann 128 Heiner Richter
129 Juan Antonio B. Bauzá 130 Joan Miralles Ramis
131 Guillem Femenias Nadal 132 Werner Goldbaum

Bảng B.2: Các user đã đăng ký (phần 2)
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Đăng ký # Tên Đăng ký # Tên
133 Egon Alber 134 Ammar Qusaibaty
135 Abdelmajid Hilali 136 Alexandre Leblanc
137 Boulag Mohamed 138 Sabah Pouzet
139 Oscar Campo 140 Costas Drossos
141 Paul Pontikis 142 Frederic Cucotti
143 <Secret> 144 Jusoh Yacob
145 LJ del Pozo 146 Martin Scholz
147 Bryn Jones 148 Arndt Baars
149 Mahdiyar Noorbala 150 Daniel Soll
151 Eugene Danicki 152 J. Antonio Seijas Macías
153 John Stiekema 154 Argyrios Zolotas
155 Mahmud Yunus 156 Theo Tuwankotta
157 Joris Naudet 158 Guillermo Coronado
159 Abdel-Rahman Jaradat 160 Magella Bédard
161 Chris Finch 162 Ruben Manvelyan
163 Eric Chin 164 Greg Georgalli
165 Priscilla Tse 166 Sylvain Leirens
167 Zofia Walczak 168 Kristina Sjösten
169 Eric Swenson 170 Attila Szegedi
171 Adel Bouchareb 172 Philippe Grégoire
173 Lars Borchert 174 Thomas Bonk
175 Samuel Setiyanto 176 Amir Wasim
177 Gerd Richter 178 David Steward
179 Tanczos Andras 180 Pere Mumbrú
181 Bernhard Nessler 182 Georgiy Shevchenko
183 Giorgos Tsapogas 184 Mehdi Chelbabi
185 Reza Danesfahani 186 Massimo Caschili
187 Philippe-Aubert Gauthier 188 Peter Sigmund
189 Charles Varin 190 Vasile Anastasoaei
191 Elefterie Olaru 192 Ivan Loncar
193 Victor Huertas Navarro 194 Otmar Bender
195 Ardi Bozon 196 Bjørn Sandvik
197 Pierre Bach 198 Pirouz Djoharian
199 <Secret> 200 Henning Heinze
201 Michael Bergman 202 J. Rao
203 Ausberto S. Castro V. 204 Ichiro Otsuka
205 Mayuresh Mukadam 206 Gerard Boland
207 Otto Icke 208 Tom Fransson

Bảng B.3: Các user đã đăng ký (phần 3)
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Đăng ký # Tên Đăng ký # Tên
209 Steven Harrod 210 Nguyễn Anh Minh
211 Addison Rios 212 Jeong-Mo Yang
213 Gustavo Cevolani 214 Lothar Fröhling
215 Tony Harker 216 Giovanni Facchini
217 Paddy Ewer 218 Vladimir Korzhik
219 Ole K. Hardangen 220 Ed Pegg Jr.
221 Louis Hotte 222 Yvon Tharrault
223 Maja Królak 224 Tim Neijens
225 Charalampos Charitos 226 Ioannis Papadoperakis
227 Costel Ionita 228 Erwann Delay
229 Sergio Celani 230 Carla Victoria V. Negret
231 Kim Mittendorf 232 Ondrej Knot
233 Till Priemer 234 Nico Feiertag
235 Pierre Leroy 236 Marko Dräger
237 Farooq Azam 238 Miko Csilla-Borbala
239 Jaime Ide 240 Benoit Chevallier-Mames
241 Swatdipisal Khatathap 242 Roman Zeiß
243 Sungpyo Hong 244 Sotirios D. Hassapis
245 Andrei ??? 246 Marc Augier
247 Daniel Hawellek 248 Marc Wendisch
249 Andrea Sorbi 250 Ted Kok
251 Christophe Tartary 252 Jeffrey Olson
253 Yannick Pannier 254 Liu Huikan
255 Henrik Sandler 256 Josep Magell
257 Keith E. Mellinger 258 Winfried Recknagel
259 Aidan Sims 260 Dinesh J. Karia
261 Derek Collis 262 Yazan Hussain
263 Anthony Gerard 264 Umar Mwidu
265 Tusiime Swaleh 266 Zara Field
267 John M. Kihoro 268 Michael K. Nganda
269 Yunjiang Jiang 270 Tuyết Vân

Bảng B.4: Các user đã đăng ký (phần 4)
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Đôi điều về tác giả

N.J.H.M. van Beurden lives in Tilburg, the Netherlands. In 1999 he
got a Bachelor (B.) degree in Electronic & Electrical Engineering
from Fontys Hogescholen Eindhoven and in 2003 he got a Master
of Science M.Sc. degree in Electronic & Electrical Engineering at
Eindhoven Univerity of Technology. Currently he is working at Philips
Semiconductors in the Netherlands as a Integrated Circuit Physical
Design Engineer.
N.J.H.M. van Beurden sống ở Tilburg, Netherlands. Tốt nghiệp
cử nhân ngành Công nghiệp Điện & Điện tử tại Đại học Fontys
Hogescholen Eindhoven năm 1999. Và lấy bằng thạc sĩ cùng ngành
năm 2003 tại Đại học kỹ thuật công nghệ Eindhoven. Hiện nay đang
làm việc cho Hãng Philips, bộ phận vật liệu bán dẫn với vai trò là kỹ
sư thiết kế mạch tích hợp.
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Danh sách hình ảnh
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